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HELLOMOTO

Das MOTORAZR2™ V8-Telefon ist schlanker, leistungsstärker und intelligenter!

• Das Telefon kann Textnachrichten, Informationen zu eingehenden Anrufen sowie Menüoptionen vorlesen 
(Seite 36). Mithilfe des externen Touchscreen-Displays können Sie die Funktionen für Musikwiedergabe, 
Nachrichten und letzte Anrufe verwenden, ohne das Telefon zu öffnen (siehe Handbuch ERSTE 
INFORMATIONEN).

• Dank der USB 2.0-Hochgeschwindigkeits-Technologie können Sie Ihre Lieblingsmusik schnell übertragen. 
Verwenden Sie dazu einfach den Microsoft® Windows® Media Player 11 (siehe Handbuch ERSTE 
INFORMATIONEN).

• Mit der 2-Megapixel-Multishot-Kamera können Sie Bilder automatisch aufnehmen (Seite 55).

• Fangen Sie wichtige Momente mit der hochauflösenden Videofunktion ein, und laden Sie Ihr Blog hoch 
(siehe Handbuch ERSTE INFORMATIONEN).

• Rufen Sie eine beliebige Website wie mit dem Computer auf. Verwenden Sie dazu den vollständigen 
HTML-Browser (Seite 54).

• Rufen Sie Ihre E-Mail-Konten (wie Hotmail, Gmail oder Yahoo) über das Internet ab (siehe Handbuch ERSTE 
INFORMATIONEN). Oder lesen und synchronisieren Sie Ihre geschäftlichen E-Mails (Microsoft Outlook) mit 
MOTOSYNC (Seite 67).
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Weitere Informationen: Drücken Sie Hauptmenü > V Hilfe, um im Telefondisplay Anweisungen zu den Funktionen 
anzuzeigen. Um Lernprogramme im Internet anzuzeigen und weitere Informationen zum Telefon und zu Zubehör 
zu erhalten, rufen Sie die Website www.hellomoto.com auf.
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Vielen Dank, dass Sie sich für das neue MOTORAZR2™ V8 GSM-Mobiltelefon entschieden haben. Die folgenden 
Abbildungen zeigen seine wesentlichen Komponenten und Bedienelemente. 

Akku-Ladeanzeige

Lautstärketasten
Signalprofil im

Standby-Display ändern, in
Menüs navigieren.

Seitliche Auswahltaste
Foto bei geschlossener

Klappe und aktiver Kamera
aufnehmen.

Micro-USB-Anschluss
Ladegerät und andere

Telefonzubehörkomponenten
anschließen.

Kameraobjektiv Bluetooth-Anzeige

Sprachbefehltaste
Mit Sprachbefehlen Anrufe 
tätigen und grundlegende 
Telefonfunktionen ausführen.

Zweiwegelautsprecher
(auf der Rückseite 
des Telefons)

Externes Display
Informationen zu eingehenden Anrufen anzeigen, 
Musik-Player bei geschlossener Klappe und aktivem 
Musik-Player steuern, als Kamerasucher bei geschlossener 
Klappe und aktiver Kamera verwenden.
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Hinweis: Dies ist das Standardlayout des Standby-Displays und des Hauptmenüs. Bei Ihrem Telefon können 
Hauptdisplay und Hauptmenü unter Umständen unterschiedlich sein. Im Handbuch ERSTE INFORMATIONEN 
finden Sie Informationen zum Ändern der Belegung der Navi-Tasten und der Hauptmenüansicht.

Drücken Sie die mittlere 
Taste s, 
um das Hauptmenü zu öffnen.

Standby-Display Hauptmenü

Halten Sie zum Einschalten 
des Telefons die 
Einschalttaste P gedrückt, 
bis das Display aufleuchtet.

Drücken Sie die 
Navigationstaste 
S 
oben/unten/rechts/ 
links, um zu einem 
Menüeintrag 
zu blättern.

Drücken Sie die 
mittlere Taste s, 
um den Eintrag 
auszuwählen.

Diensteanbieter
10/15/2008

Optionen Hauptmenü

10:10

Hauptmenü

Optionen Zurück

2

1

2

1
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Bestimmte Funktionen des Mobiltelefons sind von den 
Möglichkeiten und Einstellungen des Diensteanbieter 
abhängig. Darüber hinaus wurden manche Funktionen 
vom Diensteanbieter möglicherweise nicht aktiviert 
und/oder sind bedingt durch die Netzwerkeinstellungen 
nur eingeschränkt nutzbar. Bitte wenden Sie sich mit 
Fragen zu Verfügbarkeit und Leistungsumfang von 
Funktionen an Ihren Diensteanbieter. Alle in dieser 
Bedienungsanleitung enthaltenen Informationen 
zu Funktionen, Leistungsumfang und anderen 
Produkteigenschaften basieren auf den aktuellsten 
Informationen und sind zum Zeitpunkt der Drucklegung 
nach bestem Wissen korrekt. Motorola behält sich das 
Recht vor, Informationen oder technische Daten ohne 
vorherige Ankündigung und ohne dadurch 
irgendwelche Verpflichtungen einzugehen zu ändern.
MOTOROLA und das stilisierte M-Logo sind beim 
US-Patentamt eingetragen. Die Bluetooth-Marken 
gehören dem Eigentümer und werden von Motorola, 
Inc. unter Lizenz verwendet. Java und alle anderen 
Java-basierten Marken sind Marken oder eingetragene 
Marken von Sun Microsystems, Inc. in den USA 
und anderen Ländern. Microsoft und Windows sind 
eingetragene Marken der Microsoft Corporation 
und Windows XP und Windows Media sind Marken 
der Microsoft Corporation. Macintosh ist eine 
eingetragene Marke von Apple Computer, Inc. 
Alle anderen Produkte oder Dienstleistungen sind 
Eigentum ihrer jeweiligen Inhaber.
© Motorola, Inc., 2007.

Vorsicht: Nicht explizit von Motorola genehmigte 
Änderungen oder Modifikationen am Mobiltelefon 
führen zum Erlöschen der Betriebserlaubnis des 
Benutzers.
Software-Copyright-Hinweis
Die in diesem Handbuch beschriebenen Motorola 
Produkte enthalten möglicherweise Motorola Software 
oder Software anderer Hersteller, die in 
Halbleiterspeichern oder sonstigen Medien gespeichert 
und urheberrechtlich geschützt sind. Durch Gesetze in 
den USA und anderen Ländern werden Motorola, Inc. 
und unabhängigen Software-Herstellern Exklusivrechte 
an der urheberrechtlich geschützten Software, 
einschließlich der Exklusivrechte zum Verteilen und 
Reproduzieren der urheberrechtlich geschützten 
Software, gewährt. Demzufolge darf urheberrechtlich 
geschützte Software, die in den Produkten von 
Motorola enthalten ist, nur im gesetzlich zugelassenen 
Umfang geändert, zurückentwickelt, verteilt oder 
reproduziert werden. Darüber hinaus werden durch 
den Kauf von Motorola Produkten weder direkt, 
stillschweigend, kraft Rechtsscheins noch anderweitig 
Lizenzrechte im Rahmen der Urheberrechte, Patente 
oder Patentanmeldungen von Motorola oder eines 
anderen Software-Herstellers, ausgenommen der 
normalen, einfachen und gebührenfreien Lizenz zur 
Nutzung des Produkts, die Kraft Gesetzes beim Kauf 
eines Produkts gewährt wird, gewährt.
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SicherheitsinformationenSicherheitsrelevante und allgemeine 
Informationen

Dieser Abschnitt enthält wichtige Informationen für 
einen sicheren und effizienten Betrieb Ihres 
Mobilgeräts. Lesen Sie diese Informationen, bevor Sie 
Ihr mobiles Gerät verwenden.1

Belastung durch elektromagnetische 
Strahlung im Radio-Frequenzbereich 
(RF = Radiofrequenz)
Ihr mobiles Gerät verfügt über einen Sender und 
Empfänger. Wenn das Gerät EINGESCHALTET ist, 
überträgt und empfängt es Radio-Frequenzwellen. 
Während der Kommunikation regelt Ihr mobiles Gerät die 
Übertragungsleistung.

Ihr mobiles Gerät von Motorola wurde so entwickelt, 
dass es die behördlichen Anforderungen Ihres Landes 
hinsichtlich der RF-Belastung für Personen einhält.

1. Die in diesem Dokument bereitgestellten Informationen 
ersetzen die Allgemeinen Sicherheitsinformationen in 
allen Benutzerhandbüchern, die vor dem 1. Mai 2006 
veröffentlicht wurden.
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Vorsichtsmaßnahmen für den 
Betrieb
Um einen optimalen Betrieb Ihres Mobilgeräts und die 
Einhaltung der RF-Emissionswerte gemäß den Richtlinien 
der entsprechenden Standards zu gewährleisten, 
beachten Sie die nachfolgenden Hinweise und 
Vorsichtsmaßnahmen.

Wartung der externen Antenne
Falls Ihr mobiles Gerät über eine externe Antenne 
verfügt, verwenden Sie nur die mitgelieferte bzw. bei 
Bedarf eine von Motorola genehmigte Ersatzantenne. 
Nicht zugelassene Antennen, Änderungen oder 
Zusatzgeräte können das Mobilgerät beschädigen. Die 
Verwendung nicht zugelassener Antennen in Ihrem Gerät 
kann darüber hinaus gegen gesetzliche Vorschriften in 
Ihrem Land verstoßen.

BERÜHREN SIE DIE EXTERNE ANTENNE NICHT, wenn 
das Mobilgerät EINGESCHALTET ist. Das Berühren der 
externen Antenne beeinflusst die Qualität der 
Gesprächsverbindung und kann unter Umständen zu 
einem erhöhten Energieverbrauch des Mobilgeräts 
führen.

Betrieb des Produkts
Halten Sie Ihr Mobilgerät beim Telefonieren genau so, 
wie Sie auch ein schnurloses Festnetztelefon halten 
würden.

Wenn Sie das Mobilgerät am Körper tragen, platzieren 
Sie das Mobilgerät möglichst immer in einem von 
Motorola mitgelieferten Clip, einer Halterung, einem 
Halfter, einer Hülle oder einem Tragegurt. Falls Sie kein 
Originalzubehör von Motorola nutzen und Sie das 
Mobilgerät nicht in der normalen Position halten, achten 
Sie darauf, dass das Mobilgerät mit der Antenne 
mindestens 2,5 Zentimeter vom Körper entfernt ist, wenn 
es sendet.
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Wenn Sie das Mobilgerät – mit oder ohne Zubehörkabel – 
zur Datenübertragung benutzen, halten Sie das 
Mobilgerät und die Antenne mindestens 2,5 Zentimeter 
vom Körper entfernt.

Das Benutzen von nicht von Motorola zugelassenem 
Zubehör kann zum Überschreiten der in den gesetzlichen 
Vorschriften festgelegten Grenzwerte für die Belastung 
durch RF-Energie führen. Eine Liste der von Motorola 
gelieferten oder zugelassenen Zubehörteile finden Sie auf 
der Website von Motorola unter 
www.motorola.com.

Radio-Frequenzwellen-Interferenz/
Kompatibilität
Fast alle elektronischen Geräte sind bei unzureichender 
Abschirmung, fehlerhafter Konstruktion oder 
konstruktionsbedingt anfällig für HF-Interferenzen. Unter 
bestimmten Umständen kann Ihr mobiles Gerät 
Interferenzen mit anderen Geräten verursachen.

Befolgen Sie die Anweisungen, um 
Probleme durch Interferenzen zu 
vermeiden
Schalten Sie Ihr mobiles Gerät aus, sobald Sie durch 
entsprechende Hinweisschilder dazu aufgefordert 
werden. In öffentlichen Einrichtungen wie zum Beispiel 
Krankenhäusern oder Pflegeheimen werden häufig 
Geräte eingesetzt, die auf elektromagnetische Strahlung 
empfindlich reagieren.

Schalten Sie Ihr mobiles Gerät im Flugzeug aus, sobald 
Sie vom Personal der Fluggesellschaft dazu aufgefordert 
werden. Wenn Ihr mobiles Gerät einen Flight-Modus oder 
eine ähnliche Funktion bietet, fragen Sie das 
Flugbegleitpersonal, ob Sie das Gerät während des 
Fluges benutzen dürfen.

Herzschrittmacher
Wenden Sie sich vor der Verwendung dieses Geräts an 
Ihren Arzt, wenn Sie einen Herzschrittmacher tragen.

Personen mit Herzschrittmachern sollten folgende 
Vorsichtsmaßnahmen einhalten:
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• Das Mobilgerät IMMER mindestens 
20 Zentimeter vom Herzschrittmacher entfernt 
halten, wenn das Mobilgerät EINGESCHALTET 
ist.

• NIEMALS das Mobilgerät in einer Brusttasche 
tragen.

• Um die Gefahr von Störungen zu minimieren, 
sollte das Mobilgerät nur an das Ohr der dem 
Herzschrittmacher gegenüberliegenden 
Körperhälfte gehalten werden.

• Schalten Sie das Mobilgerät sofort AUS, sollten 
Sie den Eindruck haben, dass Störungen 
auftreten.

Hörgeräte
Einige Mobilgeräte beeinträchtigen unter Umständen die 
Funktion von Hörgeräten. Wenden Sie sich ggf. an den 
Hersteller Ihres Hörgerätes oder an Ihren Arzt, um ein 
Alternativmodell zu finden.

Weitere medizinische Geräte
Wenn Sie andere medizinische Geräte nutzen, 
kontaktieren Sie bitte Ihren Arzt oder den Hersteller, um 
zu erfragen, ob das Gerät über eine ausreichende RF-
Abschirmung verfügt.

Vorsichtsmaßnahmen beim 
Autofahren
Erkundigen Sie sich an Ihrem jeweiligen Aufenthaltsort 
nach den dort geltenden Gesetzen über das Nutzen von 
Mobilgeräten in Fahrzeugen. Halten Sie sich immer an 
diese Gesetze und Bestimmungen.

Wenn Sie beim Autofahren das Mobilgerät verwenden:

• Achten Sie immer auf den Verkehr und die 
Straße. Das Benutzen eines Mobilgeräts 
während des Fahrens kann unter bestimmten 
Umständen die Aufmerksamkeit beeinträchtigen. 
Unterbrechen Sie das Gespräch, wenn Sie sich 
nicht auf das Fahren konzentrieren können.

• Falls möglich, benutzen Sie eine 
Freisprecheinrichtung.
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• Wenn die Verkehrssituation dies erfordert, halten 
Sie zum Telefonieren an, und parken Sie, bevor 
Sie das Telefon benutzen.

Ratschläge zum verantwortlichen Fahren finden Sie unter 
„Sicherheitstipps zum Telefonieren mit Mobiltelefonen“ 
am Ende dieses Handbuchs, sowie auf der Motorola 
Website: www.motorola.com/callsmart.

Warnhinweise
Beachten Sie alle aufgestellten Hinweisschilder für den 
Gebrauch von Mobilgeräten in öffentlichen Bereichen, 
wie in Krankenhäusern oder explosionsgefährdeten 
Gebieten.

Fahrzeuge mit Airbag
Platzieren Sie ein Mobilgerät nie unmittelbar im 
Ausbreitungsbereich des Airbags.

Potenziell explosionsgefährdete 
Umgebungen
Potenziell explosionsgefährdeten Umgebungen sind oft, 
aber nicht immer als solche gekennzeichnet, wie z. B. 
Tankstellen, Betankungsbereiche auf Schiffen, Umschlag- 
und Speicherplätze für Treibstoffe oder Chemikalien, oder 
Umgebungen, in denen sich Chemikalien oder 
Schwebstoffe wie Mehlstaub, Stäube oder Metallpulver 
in der Luft befinden.

Schalten Sie Ihr Mobilgerät aus, wenn Sie sich in einer 
solchen Umgebung befinden. Vermeiden Sie es, in 
solchen Umgebungen Akkus zu entfernen, einzubauen 
oder aufzuladen. Funken können in diesen Umgebungen 
zu Explosionen oder dem Ausbruch von Feuer führen.

Beschädigte Geräte
Wenn Ihr Mobilgerät oder der Akku nass geworden, 
angeschlagen oder gar gebrochen ist, darf das Gerät erst 
wieder in Betrieb genommen werden, nachdem es von 
einem autorisierten Motorola Servicecenter untersucht 
wurde. Versuchen Sie nicht, das Gerät mit einer externen 
Wärmequelle wie beispielsweise einer Mikrowelle zu 
trocknen.
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Akkus und Ladegeräte
Akkus können Sach- und/oder 
Personenschäden verursachen, wenn 
elektrisch leitende Materialien wie 
Schmuck, Schlüssel oder Ketten mit den 
Kontaktstellen in Berührung kommen. Das leitende 
Material kann einen Stromkreis schließen (Kurzschluss) 
und sich dabei stark erhitzen. Seien Sie vorsichtig im 
Umgang mit geladenen Akkus, insbesondere, wenn Sie 
diese in einer Tasche, Geldbörse oder einem anderen 
Behälter zusammen mit metallischen Gegenständen 
aufbewahren. Benutzen Sie nur Akkus und Ladegeräte 
von Motorola (Motorola Original).

Vorsicht: Um Verletzungen zu vermeiden, werfen Sie den 
Akku niemals ins Feuer.

Auf Ihrem Akku, Ladegerät oder Mobilgerät finden Sie 
möglicherweise folgende Symbole:

Symbol Definition 
Es folgen wichtige 
Sicherheitsinformationen. 
Werfen Sie Ihren Akku oder Ihr 
mobiles Gerät nicht in offenes Feuer.

Ihr Akku oder Mobilgerät sollte 
gemäß den geltenden Gesetzen 
recycelt werden. Kontaktieren Sie die 
entsprechenden Behörden Ihres 
Landes für weitere Informationen. 
Ihr Akku oder Mobilgerät sollte nicht 
in den Hausmüll gelangen. 

Ihr Mobilgerät enthält einen internen 
Lithium-Ionen-Akku.
Ihr Akku, Ladegerät oder Mobilgerät 
sollte nicht nass werden.
Das Hören von Musik oder das 
Führen von Gesprächen über ein 
Headset bei voller Lautstärke können 
das Gehör schädigen.

032374o

032376o

032375o

032378o
Li Ion BATT
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Erstickungsgefahr
Ihr Mobilgerät oder das Zubehör kann abnehmbare Teile 
enthalten, die bei Verschlucken eine Erstickungsgefahr 
für Kleinkinder darstellen können. Halten Sie das 
Mobilgerät und das Zubehör von Kleinkindern fern.

Glasbauteile
Einige Bauteile Ihres Mobilgeräts können aus Glas 
gefertigt sein. Dieses Glas kann zerbrechen, wenn das 
Produkt auf eine harte Fläche fällt oder einen kräftigen 
Stoß erhält. Berühren oder entfernen Sie zerbrochenes 
Glas nicht vom Produkt. Verwenden Sie Ihr Mobilgerät 
solange nicht, bis das Glas durch ein qualifiziertes 
Servicecenter ersetzt wurde

Anfälle/Ohnmacht
Manche Personen zeigen eine erhöhte Bereitschaft für 
epileptische Anfälle oder Ohnmachten, wenn sie 
Blitzlichtern (Stroboskop-Effekt) ausgesetzt sind, wie sie 
beispielsweise bei Videospielen auftreten. Diese Anfälle 
oder Ohnmachten können auch bei Personen auftreten, 
die niemals zuvor einen epileptischen Anfall oder eine 
Ohnmacht hatten.

Wenn Sie schon einmal einen epileptischen Anfall oder 
eine Ohnmacht hatten, oder wenn es einen derartigen 
Fall in Ihrer Familie gibt, beraten Sie sich mit einem Arzt, 
bevor Sie ein Videospiel auf dem Mobilgerät spielen oder 
einen stroboskopartigen Lichteffekt (sofern als Funktion 
enthalten) im Mobilgerät aktivieren.
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Personen, bei denen eines der folgenden Symptome 
auftritt, sollten unverzüglich die Nutzung des Geräts 
einstellen und einen Arzt aufsuchen: Krämpfe, Augen- 
oder Muskelzucken, Bewusstlosigkeit, 
Bewegungsstörungen oder Desorientierung. Sie sollten 
das Display immer von Ihren Augen entfernt halten, in 
einer hell erleuchteten Umgebung spielen, stündlich eine 
Pause von 15 Minuten einlegen und keine Videospiele 
spielen, wenn Sie übermüdet sind.

Warnhinweis: Verwendung mit zu 
hoher Lautstärke

Das Hören von Musik oder das Führen von 
Gesprächen über ein Headset bei voller 
Lautstärke können das Gehör schädigen.

Übermäßige Belastung
Wenn Sie wiederholt die gleichen Aktionen ausführen, 
wie beispielsweise das Drücken von Tasten oder das 
Eingeben von alphanumerischen Zeichen, können 
gelegentlich Verspannungen an Händen, Armen, 
Schultern, Nacken oder anderen Körperteilen auftreten. 
Wenn Sie während oder nach dem Spielen anhaltende 
Schmerzen an Händen, Gelenken oder Armen verspüren, 
hören Sie sofort mit dem Spielen auf, und suchen Sie 
einen Arzt auf.
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Hinweise betreffend FCC (Federal Communications Commission)Benutzerhinweise betreffend FCC (Federal 
Communications Commission)

Die folgende Erklärung gilt für alle Produkte, für die eine 
FCC-Zulassung vorliegt. Die betreffenden Produkte 
tragen das FCC-Logo und/oder eine 
FCC-Identifikationsnummer nach dem Muster: xxxxxx auf 
dem Produkt-Etikett.

Veränderungen oder Modifizierungen an diesem Gerät 
durch den Benutzer sind nicht zulässig. Alle Änderungen 
oder Modifizierungen durch den Benutzer können 
zu einem Entzug der Benutzungsgenehmigung für das 
Gerät führen. Siehe Code of Federal Regulations (CFR) 
47, Abschnitt 15.21.

Dieses Gerät entspricht Kapitel 15 der FCC-Vorschriften. 
Die Inbetriebnahme unterliegt folgenden zwei 
Bedingungen: (1) Dieses Gerät darf keine schädlichen 
Interferenzen verursachen. (2) Das Gerät muss jegliche 
empfangenen Interferenzen aufnehmen können, 
einschließlich Interferenzen, die den ordnungsgemäßen 
Betrieb stören können. Siehe CFR 47, Abschnitt 15.19(3).

Wenn Ihr Mobilgerät oder entsprechendes Zubehör über 
einen USB-Anschluss verfügt oder anderweitig zu 
Computer-Peripheriegeräten zählt, die zum Zwecke des 
Datentransfers an Computer angeschlossen werden 
können, dann gilt es als Gerät der Klasse B, für das 
folgende Erklärung Gültigkeit hat:
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Tests mit diesem Gerät haben ergeben, dass es alle 
gültigen Beschränkungen für Digitalgeräte der Klasse B 
gemäß  Kapitel 15 der FCC-Vorschriften einhält. Mit 
diesen Beschränkungen soll ein angemessener Schutz 
gegen schädliche Interferenzen bei der Verwendung 
innerhalb von Wohngebieten geschaffen werden. Dieses 
Gerät erzeugt und verwendet Hochfrequenzenergie und 
kann diese abstrahlen. Bei unsachgemäßer Verwendung 
kann es schädliche Interferenzen im Funkverkehr 
verursachen. In Einzelfällen kann es jedoch auch bei 
sachgemäßer Verwendung zu Interferenzen kommen. 
Falls dieses Gerät den Radio- oder Fernsehempfang 
negativ beeinflusst (dies lässt sich durch Aus- und 
Anschalten des Gerätes überprüfen), sollten folgende 
Korrekturmaßnahmen ergriffen werden:

• Ändern Sie Ausrichtung oder Standort der 
Empfangsantenne.

• Vergrößern Sie den Abstand zwischen Gerät und 
Empfänger.

• Stecken Sie das Gerät an einer Steckdose ein, 
die an einem anderen Stromkreis als der 
Empfänger angeschlossen ist.

• Wenden Sie sich bei Problemen an einen 
Elektrofachhändler oder Fernmeldetechniker.
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Benutzung und PflegeBenutzung und Pflege

Schützen Sie Ihr Mobiltelefon von Motorola vor:

Flüssigkeiten jeder Art Staub und Schmutz
Setzen Sie das Telefon weder Wasser, 
Regen, extremer Luftfeuchtigkeit, 
Schweiß noch anderer Feuchtigkeit aus.

Setzen Sie das Telefon weder Staub, 
Schmutz, Sand, Nahrungsmittelresten 
noch anderen Reststoffen aus.

Extreme Hitze oder Kälte Reinigungsmittel
Meiden Sie Temperaturen unter -10° C 
und über 45° C.

Reinigen Sie das Telefon mit einem 
trockenen weichen Tuch. Verwenden 
Sie weder Alkohol noch andere 
Reinigungsmittel.

Mikrowellenherd Stöße
Trocknen Sie das Telefon nicht in einem 
Mikrowellenherd.

Lassen Sie das Telefon nicht fallen.
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EU-Richtlinien KonformitätserklärungEU-Richtlinien Konformitätserklärung

Hiermit erklärt Motorola, dass dieses Produkt 
den folgenden Richtlinien entspricht:

•Den wesentlichen Anforderungen und 
allen anderen relevanten Bestimmungen 
der Richtlinie 1999/5/EG

•Allen anderen relevanten EU-Richtlinien

Die obige Abbildung zeigt ein Beispiel für eine typische 
Produktgenehmigungsnummer.

Sie können die der Richtlinie 1999/5/EG (die R&TTE-
Richtlinie) zugehörige Konformitätserklärung (DoC) zu 
Ihrem Produkt unter der Internetadresse 
www.motorola.com/rtte abrufen. Geben Sie dazu die auf 
dem Typenschild Ihres Produkts angegebene 
Genehmigungsnummer in das auf der Website 
befindliche Feld „Suchen“ ein.

0168 Produkt-
genehmigungs-

nummer
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Informationen zum RecyclingSchutz der Umwelt durch Recycling

Produkte von Motorola, die dieses Zeichen 
tragen, dürfen nicht als Hausmüll entsorgt 
werden.

Recycling von Mobiltelefonen und Zubehör

Mobiltelefone oder elektronisches Zubehör, wie 
Ladegeräte oder Headsets, dürfen nicht als Hausmüll 
entsorgt werden. In manchen Ländern wurden spezielle 
Sammelsysteme für Elektroschrott und elektronische 
Geräte eingerichtet. Nähere Informationen erteilen 
örtliche Behörden. Falls keine Sammelsysteme verfügbar 
sind, wenden Sie sich bzgl. der Entsorgung Ihres nicht 
mehr benötigten Mobiltelefons oder elektronischen 
Zubehörs an ein von Motorola autorisiertes 
Servicecenter.
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Grundlagen

Informationen zu diesem 
Handbuch
Dieses Handbuch verwendet für das Öffnen einer 
bestimmten Menüfunktion die folgende Schreibweise:

Zu finden unter: s > g Nachrichten > Neue Nachricht

Das bedeutet, dass Sie ausgehend vom 
Standby-Display folgendermaßen vorgehen:
  1 Drücken Sie zum Öffnen des Hauptmenüs 

die mittlere Taste s.

2 Drücken Sie die Navigationstaste S, um zu g 
Nachrichten zu blättern, und drücken Sie die mittlere 
Taste s, um dieses Menü auszuwählen.

3 Drücken Sie die Navigationstaste S, um zu 
Neue Nachricht zu blättern, und drücken Sie die 
mittlere Taste s, um diese Option auszuwählen.

Vorsicht: Machen Sie sich vor der ersten 
Inbetriebnahme Ihres Mobiltelefons mit den 
Sicherheitsinformationen im Benutzerhandbuch 
vertraut, die in der Verpackung enthalten sind. 
Lesen Sie zur sicheren Anwendung Ihres 
Mobiltelefons diese Informationen von Zeit zu Zeit 
erneut durch.
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Akku

Akku aufladen
 Tipp: Die Schaltkreistechnik der Motorola-Akkus 
schützen den Akku vor Schäden durch Überladung.

Hinweis: Sie können den Akku aufladen, 
indem Sie das Telefon über den 
Micro-USB-Anschluss mit dem 

USB-Anschluss eines Computers verbinden. Telefon 
und Computer müssen eingeschaltet sein, und im 
Computer müssen die richtigen Softwaretreiber 
installiert sein. Ein Motorola Original-USB-Kabel und 
die zugehörige Software sind ggf. im Lieferumfang 
des Telefons enthalten. Dieses Zubehör ist auch 
separat erhältlich.

Akku – Verwendung und Sicherheit
• Motorola empfiehlt 

ausschließlich die Verwendung 
von Akkus und Ladegeräten der 
Marke Motorola. Die Garantie 
deckt keine Schäden ab, die durch Akkus 
und/oder Ladegeräte verursacht werden, 
die nicht von Motorola stammen. 

Vorsicht:  Die Verwendung eines nicht 
geeigneten Akkus oder Ladegeräts kann 
zu Feuer, Explosion, Undichtheit oder 
sonstigen gefährlichen Situationen führen. 

Symbole

Dieses Symbol kennzeichnet Funktionen, 
die vom Netz, der SIM-Karte bzw. Ihrem 
Mobilfunkvertrag abhängig sind und 
möglicherweise nicht überall angeboten 
werden. Weitere Informationen erhalten 
Sie von Ihrem Diensteanbieter.

Mit diesem Zeichen werden Funktionen 
gekennzeichnet, die optionales Zubehör 
erfordern.
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Die Verwendung eines nicht geeigneten 
oder eines beschädigten Akkus kann zu Feuer, 
Explosion oder sonstigen gefährlichen 
Situationen führen.

• Kinder dürfen den Akku nicht unbeaufsichtigt 
verwenden.

• Wichtig: Die beste Leistung für die Mobilgeräte 
von Motorola wird mit geeigneten Akkus 
erzielt. Wenn auf dem Display eine Meldung 
angezeigt wird, wie z. B. Ungültiger Akku oder 
Laden nicht möglich, führen Sie die folgenden 
Schritte aus:

• Nehmen Sie den Akku heraus, und prüfen 
Sie, ob er das Hologramm „Original 
Equipment“ von Motorola trägt.

• Wenn kein Hologramm vorhanden ist, 
handelt es sich nicht um einen 
geeigneten Akku.

• Wenn ein Hologramm vorhanden ist, 
setzen Sie den Akku erneut ein, und 
starten Sie den Ladevorgang neu.

• Wenn die Meldung weiterhin angezeigt 
wird, wenden Sie sich an den 
Motorola-Kundendienst.

• Bei neuen Akkus oder Akkus, die über 
einen längeren Zeitraum gelagert wurden, 
ist eventuell eine längere Ladezeit erforderlich.

• Vorsichtsmaßnahmen beim Laden: 
Das Laden der Akkus sollte bei 
Raumtemperatur durchgeführt werden. 
Setzen Sie Akkus während des Ladevorgangs 
nie Temperaturen unter 0 °C oder über 45 °C 
aus. Lassen Sie Ihr Mobilgerät nicht im 
Fahrzeug zurück.

• Akkus sollten an einem kühlen und trockenen 
Ort gelagert werden.
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• Mit der Zeit verringert sich die Akkulebensdauer, 
und der Akku weist kürzere Laufzeiten 
zwischen den Ladevorgängen auf oder 
benötigt häufigere oder längere Ladezeiten.

• Vermeiden Sie Schäden am Akku oder am 
Mobilgerät. Der Akku oder das Mobilgerät 
dürfen nicht zerlegt, geöffnet, zerdrückt, 
verbogen, deformiert, punktiert, 
geschreddert oder in Flüssigkeit getaucht 
werden. Der Akku oder das Mobilgerät dürfen 
nicht herunterfallen, insbesondere nicht auf 
eine harte Oberfläche. Wenn der Akku oder 
das Mobilgerät solche Schäden aufweist, 
wenden Sie sich vor der Verwendung an den 
Motorola-Kundendienst. Versuchen Sie nicht, 
den Akku oder das Mobilgerät mithilfe eines 
Geräts oder einer Wärmequelle, wie z. B. einem 
Haarfön oder einer Mikrowelle, zu trocknen.

• Verwenden Sie einen geladenen Akku mit 
größter Sorgfalt – besonders, wenn Sie ihn in 
eine Tasche, einen Geldbeutel oder in einen 
Behälter mit Metallobjekten stecken bzw. legen. 
Der Kontakt mit Metallobjekten (z. B. Schmuck, 
Schlüssel, Perlenketten) kann einen 
elektrischen Stromkreis bilden (Kurzschluss), 
wodurch der Akku sehr heiß werden kann. Dies 
kann zu Schäden oder Verletzungen führen.

Entsorgen Sie verbrauchte Akkus sofort 
entsprechend den örtlichen Bestimmungen. 
Hinweise zum ordnungsgemäßen Entsorgen 
erhalten Sie bei Ihrer lokalen Recycling-Stelle.

Vorsicht: Verbrennen Sie Akkus niemals, da sie 
explodieren können.
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Grundlagen

Display
Das Standby-Display wird beim Einschalten des 
Telefons angezeigt.

Hinweis: Je nach den von Ihrem Netzbetreiber 
getroffenen Voreinstellungen kann das 

Standby-Display Ihres Mobiltelefons von dieser 
Abbildung abweichen.

Im Standby-Display müssen Sie zum Wählen einer 
Rufnummer nur die Ziffern eingeben und N drücken.

Drücken Sie die mittlere Taste s oder den Softkey 
Hauptmenü, um das Hauptmenü zu öffnen.

Drücken Sie im Standby-Display Optionen, um die 
externen (seitlichen) Tasten zu sperren, einen Alarm 
einzustellen, ein Foto aufzunehmen, eine Nachricht 
zu senden, das Signalprofil zu ändern, den 
Flugzeugmodus zu aktivieren oder das Standby-Display 
zu personalisieren.

Drücken Sie im Standby-Display die Navigationstaste 
S oben, unten, links oder rechts, um die dort 
hinterlegten Funktionen zu öffnen. Informationen 
zum Anzeigen, Ausblenden oder Ändern der 

Uhrzeit

Softkey-Label
links HauptmenüOptionen

Datum

10:10

Diensteanbieter
10/15/2008

Softkey-Label 
rechts

Funktionssymbole
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Funktionssymbole im Standby-Display finden Sie 
im Handbuch ERSTE INFORMATIONEN.

Tipp: Sie benötigen Hilfe? Drücken Sie Hauptmenü  > V 
Hilfe. Wählen Sie ein Hilfe-Thema aus, um Informationen 
über Funktionen des Mobiltelefons zu erhalten.

Am oberen Rand des Standby-Displays können die 
folgenden Statussymbole angezeigt werden:

 1 Signalstärke – Zeigt die Stärke des Netzsignals an.

2 EDGE/GPRS – Zeigt an, 
dass das Mobiltelefon eine 
Hochgeschwindigkeitsdatenverbindung Enhanced 
Data for GSM Evolution (EDGE) Z oder General 
Packet Radio Service (GPRS) g verwendet.

3 Bluetooth®-Symbol – Zeigt den 
Bluetooth-Status an:

4 IM-Anzeige (Instant Messaging) – Zeigt 
den aktiven IM-Status an:

5 IM-Anzeige – Dieses Symbol wird 
angezeigt, wenn Sie eine neue 
IM-Nachricht erhalten haben.

2 1061 3 984 5 7

& leuchtet blau = Bluetooth aktiviert

& leuchtet grün = Bluetooth verbunden

& blinkt blau = Bluetooth-Erkennungsmodus

0 (grün) = online 2 = offline

Y = besetzt 4 = diskret

3 (grau) = für IM unsichtbar
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6 Nachrichtensymbol – Wird angezeigt, 
wenn Sie eine neue Nachricht erhalten. 
Text- oder Sprachnachricht. Beispiele für 
weitere Datenverbindungssymbole:

7 Standortbestimmung – P wird angezeigt, 
wenn das Mobiltelefon Informationen zur 
Standortbestimmung an das Netz senden kann 
oder Q wird angezeigt, wenn die 
Standortbestimmung deaktiviert ist.

8 Profilanzeige – Zeigt das eingestellte 
Signalprofil an:

9 Aktive Leitung – Das Symbol B weist auf 
eine aktive Verbindung, das Symbol E 
auf die aktivierte Rufumleitung hin.

10 Akkuladezustand – Vertikale Balken zeigen den 
Akkuladezustand an. Bei Anzeige der Meldung 
Akku fast leer muss das Mobiltelefon aufgeladen 
werden.

V= E-Mail-Nachricht T = Sprachnachricht

N = Nur Klingelton J = Kein Signal

H = Nur vibrieren I = Vibrieren, dann 
Klingelton
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Texteingabe
Bei einigen Funktionen können Sie Text eingeben.

So ändern Sie die Einstellungen für Texteingabe und 
Sprache:

Zu finden unter: s > u Setup > Telefon > Texteingabe

Großschreibung ändern: Drücken Sie 0, 
um zwischen den Modi „Großbuchstaben“ (Ä), 
„Wortanfang groß“ (Í) oder „Kleinbuchstaben“ 
(kein Symbol) zu wechseln.

kd

Der blinkende Cursor gibt 
den Einfügepunkt an.

Drücken Sie Optionen,
um die Optionen für

Texteingabe zu ändern.

Senden anOptionen

Drücken Sie #, um einen
Texteingabemodus auszuwählen.

Neue Nachricht
SMS:0

Zeichenzähler

Texteingabemodi

Ê „Wort“-Modus (siehe Seite 29)

É „abc“-Modus (siehe Seite 30)

È Numerischer Modus (siehe Seite 31)

Ã Symbolmodus (siehe Seite 31)
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Wortlernfunktion aktivieren: Das Telefon kann 
eingegebene neue Wörter lernen, um die vereinfachte 
Texteingabe und Wortergänzung zu verbessern. 
Drücken Sie Optionen > Texteingabe > Vereinfachte Texteingabe 
> Wörter lernen. Wenn die Funktion aktiviert ist, wird das 
Symbol b angezeigt.

Wortergänzung aktivieren: Stellen Sie das Telefon so 
ein, dass bei Eingabe von mindestens drei Buchstaben 
in einer Zeile das Telefon das Wort vervollständigt. 
Geben Sie ein Wort ein, und drücken Sie Optionen 
> Texteingabe > Vereinfachte Texteingabe > Wort vervollständigen. 
Wenn die Funktion aktiviert ist, wird das Symbol Ç 
angezeigt.

Interpunktionszeichen eingeben: Drücken Sie 1 
für die Eingabe von Satzzeichen oder anderen Zeichen.

Text bearbeiten oder löschen: Drücken Sie S, 
um den Cursor rechts neben den Text zu verschieben, 
den Sie bearbeiten möchten. Drücken Sie die 
Löschen-/Rücktaste D, um das Zeichen links 
vom Cursor zu löschen. Halten Sie D gedrückt, 
um das gesamte Wort zu löschen.

Wort-Modus
Drücken Sie # in einem Texteingabebildschirm, 
um bei der Texteingabe zum Wort-Modus der 
vereinfachten Texteingabe zu wechseln. Im Display 
wird Ê angezeigt.

Der Wort-Modus ermöglicht die vereinfachte Eingabe 
von Wörtern mit nur einem Tastendruck pro Buchstabe. 
Das Telefon schlägt mögliche Wörter für die bisher 
gedrückte Tastenkombination vor.
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Wenn Sie beispielsweise 7 7 6 4 drücken, 
wird im Display möglicherweise Folgendes angezeigt:

abc-Modus
Drücken Sie # in einem Texteingabebildschirm, um 
zum „abc“-Texteingabemodus zu wechseln. Das 
Symbol É wird im Display angezeigt.

Die Texteingabe erfolgt durch wiederholtes Drücken 
einer Taste, um durch die der Taste entsprechenden 
Buchstaben, Ziffern und Symbole zu blättern. 
Wiederholen Sie diesen Schritt für jeden Buchstaben, 
den Sie eingeben möchten.

Wenn Sie beispielsweise die Taste 7 ein Mal 
drücken, wird im Display möglicherweise Folgendes 
angezeigt:

Prog ram
ke

Drücken Sie 
D, um das 
Zeichen links 
vom Cursor 
zu löschen.

Drücken Sie
S oben/

unten,
um weitere

Wörter
anzuzeigen.

Drücken
Sie s,

um ein Wort
auszuwählen.

Senden anOptionen

Drücken Sie
*, um Prog

und ein
Leerzeichen
einzugeben.

Neue Nachricht
SMS:4

Sie können die 
Textergänzung 
aktivieren 
(e) oder 
deaktivieren 
(b).

P rog
je

Zeichen
wird am

Einfügepunkt
angezeigt.

Neue Nachricht
SMS:4

Nach zwei 
Sekunden wird 
das Zeichen 
akzeptiert, und 
der Cursor 
springt zur 
nächsten 
Position.

Senden anOptionen
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Wenn die Wortergänzung aktiviert ist, versucht das 
Telefon, das restliche Wort zu vervollständigen:

• Drücken Sie s, um das vorgeschlagene Wort 
auszuwählen.

• Drücken Sie S rechts, um das 
vorgeschlagene Wort und ein Leerzeichen 
einzugeben.

• Wenn Sie ein anderes Wort wünschen, tippen 
Sie die restlichen Buchstaben über die 
Tastatur ein.

Numerischer Modus
Drücken Sie # in einem Texteingabebildschirm, 
bis È angezeigt wird. Geben Sie dann 
die gewünschten Ziffern ein.

Tipp: Sie möchten nur eine Zahl eingeben? 
Zum schnellen Eingeben einer Zahl halten Sie 
eine Zifferntaste solange gedrückt, bis die Zahl 
angezeigt wird.

Symbole
Drücken Sie # in einem Texteingabebildschirm, 
bis Ã angezeigt wird. Im Display wird das Symbol 
der jeweiligen Taste angezeigt. Drücken Sie 
wiederholtS oben/unten, um verschiedene Symbole 
anzuzeigen. Um ein Symbol einzufügen, drücken Sie 
die jeweilige Taste, oder blättern Sie zu dem Symbol, 
und drücken Sie s.

Lautstärke
Mithilfe der Lautstärketasten 
können Sie:

• Das Anrufsignal 
abschalten

• Die Lautstärke der Hörmuschel oder des 
Lautsprechers während eines Anrufs ändern
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• Die Lautstärke während der Wiedergabe eines 
Lieds oder eines Videos ändern

• Das Signalprofil im Standby-Display festlegen 
(drücken Sie die Lautstärketasten, um zu einem 
Profil zu blättern, drücken Sie anschließend 
s oder die seitliche Auswahltaste, um das 
Profil auszuwählen)

Navigationstaste
Drücken Sie die Navigationstaste 
S oben, unten, links oder 
rechts, um zu einem 
Menüeintrag zu blättern. 
Sie können diesen dann durch 
Drücken von s auswählen.

Seitliche Auswahltaste
Die seitliche Auswahltaste ist 
eine weitere Möglichkeit zum 
Durchführen bestimmter 
Aktionen. Wenn Sie z. B. zu 
einem Menüelement blättern, 
können Sie dieses durch Drücken der seitlichen 
Auswahltaste (statt s) auswählen.

Tipp: Drücken Sie im Standby-Display die seitliche 
Auswahltaste, um die Kamera zu aktivieren.

Externes Display
Bei geschlossener Telefonklappe zeigt das externe 
Display die Uhrzeit und den Telefonstatus, eingehende 
Anrufe und andere Ereignisse an. Eine Liste der 
Statussymbole finden Sie auf Seite 26.



33Grundlagen

Signaltyp im externen Display 
einstellen
Drücken Sie die externen Lautstärketaste seitlich am 
Telefon, um zu einem Profil zu blättern. Drücken Sie 
anschließend die seitliche Auswahltaste, um das Profil 
auszuwählen.

Rückruf bei verpassten Anrufen 
ohne Öffnen des Mobiltelefons
Das Mobiltelefon erfasst unbeantwortete Anrufe und 
auf dem externen Display wird die Meldung x entgangene(r) 
Anruf(e) angezeigt. Dabei bezeichnet X die Anzahl der 
verpassten Anrufe.

Tipp: Wenn die Telefonklappe geschlossen 
ist, sind das Mikrofon und die Hörmuschel 
verdeckt. Daher müssen Sie zum Absetzen und 
Annehmen von Gesprächen ein Headset oder eine 
andere Freisprecheinrichtung einsetzen.

 1 Drücken Sie die seitliche Auswahltaste 
(siehe Abbildung auf Seite 3), um die Liste der 
eingegangenen Anrufe anzuzeigen.

2 Drücken Sie die externen Lautstärketasten seitlich 
am Telefon, um zu einem unbeantworteten Anruf 
zu blättern.

• Um die Nummer zu wählen, halten Sie die 
seitliche Auswahltaste gedrückt.

• Wenn Sie keinen Rückruf durchführen 
möchten, drücken Sie kurz die seitliche 
Auswahltaste, um den Vorgang abzubrechen.

Sprachbefehle
Mit Sprachbefehlen können Sie dem Telefon 
Anweisungen erteilen.

Hinweis: Sprachbefehle werden nicht für alle Sprachen 
unterstützt.
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Sprachwahl
Sie können einen Eintrag in Ihrer Kontaktliste anrufen, 
indem Sie den Namen des Eintrags oder die einzelnen 
Ziffern einer Rufnummer sprechen.
  1 Halten Sie die externe Sprachbefehltaste seitlich 

am Telefon gedrückt. Das Telefon lädt die 
Spracherkennungssoftware und fordert Sie dann 
auf, einen Befehl oder Namen zu sprechen.

2 Warten Sie auf den Signalton, bevor Sie den 
Namen eines Eintrags aus der Kontaktliste 
sprechen. Das Telefon bestätigt den Namen 
und die Verbindung wird hergestellt.

oder

Sagen Sie „Nummer wählen“. Sie werden 
aufgefordert, die Ziffern der Rufnummer zu 
sprechen. Sprechen Sie die Ziffern. Das Telefon 
bestätigt die Nummer und die Verbindung wird 
hergestellt.

Tipps:

• Sie können den Namen des Kontakts und den 
Nummerntyp zusammen sprechen. Sagen Sie 
z. B. „John Smith Mobil“, um die für John 
Smith gespeicherte Mobilnummer anzurufen.

• Um die Sprachbefehlhilfe aufzurufen, drücken 
Sie die Sprachbefehltaste seitlich am Telefon 
und anschließend Hilfe.

Telefonfunktionen per 
Sprachbefehl aktivieren
Mit Sprachbefehlen können Sie Anwendungen öffnen 
und viele grundlegende Telefonfunktionen ausführen.
  1 Halten Sie die externe Sprachbefehltaste seitlich 

am Telefon gedrückt. Das Telefon fordert Sie auf, 
einen Befehl zu sprechen.
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2 Warten Sie auf den Signalton, bevor Sie einen 
Sprachbefehl aus der Liste sprechen.

Tipp: Drücken Sie kurz die Sprachbefehltaste seitlich 
am Telefon, um die Liste der Sprachbefehle anzuzeigen.

Sprachbefehle

„Name“ 

„Nummer wählen“ 

„Nachricht senden an Name“ 

„Kalender prüfen“ 

„Nachrichteneingang prüfen“ 

„E-Mail-Eingang prüfen“ 

„Neuer Kontakt“ 

„Sprachmodus“ 

„Akku prüfen“ 

„Signalstärke prüfen“ 

„Uhrzeit anzeigen“ 

„Datum anzeigen“ 

„Telefon-Setup öffnen“ 

„Anrufliste öffnen“ 

„Themes öffnen“ 

„Kamera öffnen“ 

„Browser Menü öffnen“ 

„Flugzeugmodus einschalten“ 

„Flugzeugmodus abschalten“ 

„Klingelton einstellen“ 

„Normal einstellen“ 

„Vibration einstellen“ 

„Stumm einstellen“ 

Sprachbefehle
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Sprachmodus
Sie können Ihr Telefon so einstellen, dass es 

• Die Anrufer-ID eingehende Anrufe vorliest

• Menü- und Kontakteinträge vorliest

• Zahlen vorliest

• E-Mails und Nachrichten vorliest

Zu finden unter: s > u Setup > Telefon > Sprachmodus

Schnellzugriff: Halten Sie die externe 
Sprachbefehltaste seitlich am Telefon gedrückt. Wenn 
Sie vom Telefon aufgefordert werden, einen Befehl 
zu sprechen, sagen Sie „Sprachmodus“. 

Freisprechfunktion
Zum Einschalten der Freisprechfunktion während 
eines Gesprächs drücken Sie Optionen > Lautsprecher ein. 
Im Display wird bis zum Ausschalten der 

Freisprechfunktion (drücken Sie Optionen > Lautsprecher aus) 
oder dem Auflegen das Lautsprechersymbol angezeigt.

Hinweis: Die Benutzung von Mobiltelefonen kann beim 
Führen eines Kfz Ablenkungen verursachen. Beenden 
Sie das Gespräch, wenn Sie sich nicht ausreichend auf 
das Fahren konzentrieren können. Der Einsatz von 
Mobilfunkgeräten und deren Zubehör ist in einigen 
Regionen eventuell verboten oder nur eingeschränkt 
erlaubt. Die Gesetze und Vorschriften über die Nutzung 
dieser Produkte müssen stets eingehalten werden.

Codes und Passwörter
Der vierstellige Entsperrcode Ihres Telefons ist 
werkseitig auf 1234 eingestellt. Der sechsstellige 
Sicherheitscode ist werkseitig auf 000000 eingestellt. 
Sofern der Diensteanbieter diese Codes nicht geändert 
hat, sollten Sie dies vornehmen:

Zu finden unter: s > u Setup > Sicherheit 
> Passwörter ändern
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Sie können außerdem Ihre SIM PIN-Codes oder das 
Kennwort für die Anrufsperre ändern.

Falls Sie Ihren Entsperrcode vergessen: Geben Sie 
an der Eingabeaufforderung Bitte Entsperrcode eingeben 
versuchsweise 1234 oder die letzten vier Ziffern Ihrer 
Telefonnummer ein. Sollte dies nicht funktionieren, 
drücken Sie #, und geben Sie stattdessen den 
sechsstelligen Sicherheitscode ein.

Falls Sie einen anderen Code vergessen sollten: 
Wenn Sie den PIN- oder PIN2-Code der SIM-Karte 
oder das Passwort für die Anrufsperre vergessen 
haben, wenden Sie sich an Ihren Diensteanbieter.

Seitentasten sperren und 
freigeben
Sie können bei geschlossener Telefonklappe 
die externen Tasten des Telefons sperren, 
um versehentliches Tastendrücken (z. B. beim 

Tragen des Telefons in der Handtasche oder 
Hosentasche) zu vermeiden.

So sperren Sie die externen Tasten manuell: Schließen 
Sie die Telefonklappe, und halten Sie die seitliche 
Auswahltaste gedrückt. Die externen Tasten bleiben 
solange gesperrt, bis Sie die Telefonklappe öffnen.

So sperren Sie die externen Tasten automatisch, wenn 
das Telefon im Standby-Modus und die Telefonklappe 
geschlossen ist:

Zu finden unter: s > u Setup > Sicherheit 
> Externe Tastensperre > Timer

Sie können die Zeitverzögerung für das Sperren der 
externen Tasten einstellen (2 Sekunden, 4 Sekunden oder 
8 Sekunden). Die Tasten werden gesperrt, sobald Sie die 
Telefonklappe schließen. Wenn Sie die Telefonklappe 
öffnen, werden die Tasten entsperrt.

So deaktivieren Sie die automatische Sperrfunktion:

Zu finden unter: s > u Setup > Sicherheit 
> Externe Tastensperre > Timer > Aus
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So entsperren Sie die externen Tasten bei 
geschlossener Klappe: Halten Sie die seitliche 
Auswahltaste gedrückt.

Mobiltelefon 
sperren/entsperren
Sie können das Mobiltelefon sperren, damit es 
niemand außer Ihnen benutzen kann. Zum Sperren 
oder Entsperren Ihres Telefons benötigen Sie den 
vierstelligen Entsperrcode.

Manuelle Sperre des Mobiltelefons:

Zu finden unter: s > u Setup > Sicherheit > Telefonsperre 
> Jetzt sperren

Automatische Sperre des Mobiltelefons bei jedem 
Ausschalten:

Zu finden unter: s > u Setup > Sicherheit > Telefonsperre 
> Einschaltsperre > Ein

Notrufe können auch getätigt werden, wenn das 
Telefon gesperrt ist (siehe Seite 48).
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Personalisieren

Profile
Sie können das Signalprofil des Telefons schnell an 
Ihre Aktivitäten oder Umgebung anpassen. In jedem 
Profil können Sie unterschiedliche Signaltöne oder 
Vibrationsalarme für eingehende Anrufe und andere 
Ereignisse festlegen. Das Signalprofil wird oben im 
Standby-Display angezeigt:

So ändern Sie Ihr Profil: Drücken Sie im 
Standby-Display die externen Lautstärketasten seitlich 

am Telefon. Sie können im Standby-Display auch 
Optionen > Signaltyp ändern oder Profil ändern drücken.

Das Profil Stumm stellt Ihr Mobiltelefon solange stumm, 
bis Sie ein anderes Profil einstellen.

Schnellzugriff: Halten Sie im Standby-Display # 
gedrückt, um das Profil schnell in Vibrieren zu ändern.

Signalprofil-Einstellungen 
ändern
Sie können die Signaltöne ändern, die für eingehende 
Anrufe und andere Ereignisse verwendet werden. 
Sie können auch die Signallautstärke, die 
Tastenlautstärke und die Lautstärke für die 
Mediadateien ändern. Bei SIM-Karten mit zwei 

N Klingelton J Stumm

H Vibrieren I Vibr. dann Klingelton
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Rufnummern können Sie verschiedene Klingeltöne 
einstellen, um eingehende Anrufe auf Leitung 1 oder 
Leitung 2 zu unterscheiden.

Zu finden unter: s > u Setup > Profile > Optionen 
> Bearbeiten
  1 Drücken Sie S links/rechts, um die Registerkarte 

Signale [, Lautstärke i, Nachrichten ] 
oder Einstellungen # auszuwählen.

2 Drücken Sie S oben/unten, um zur Signal- oder 
Lautstärkeeinstellung zu blättern, die Sie ändern 
möchten. Drücken Sie dann s.

3 Wählen Sie die gewünschte Einstellung.

4 Drücken Sie Zurück, um die Änderungen zu 
speichern und das Menü zu beenden.

So führen Sie das Zurücksetzen der 
Standardeinstellungen für einen Signaltyp aus:

Zu finden unter: s > u Setup > Profile > Optionen 
> Bearbeiten > Optionen > Zurücksetzen.

Neues Profil erstellen
So erstellen Sie ein neues Profil mit den gewünschten 
Signaltönen und Lautstärkeeinstellungen:

Zu finden unter: s > u Setup > Profile > Optionen 
> Profil erstellen
  1 Geben Sie einen Namen ein und ändern 

die Einstellungen wie im vorherigen Abschnitt 
beschrieben.

2 Drücken Sie Speichern.

Hinweis: Einstellungen für ein Signalprofil können auch 
durch ein Theme bestimmt werden. Durch Auswahl der 
Option „Nach Theme festlegen“ wird das Profil 
geändert, um die Signaleinstellungen des Themes zu 
verwenden.
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Profile bearbeiten oder löschen
So bearbeiten Sie ein Profil:

Zu finden unter: s > u Setup > Profile, blättern 
Sie zum Profil, drücken Sie Optionen > Bearbeiten.

Hinweis: Das Profil Stumm kann nicht geändert werden.

So löschen Sie ein benutzerdefiniertes Profil:

Zu finden unter: s > u Setup > Profile, blättern 
Sie zum Profil, drücken Sie Optionen > Profil löschen.

Zeit und Datum
Das Telefon kann die Uhrzeit und das Datum 
automatisch aktualisieren. Die Zeit sowie das 
Datum werden für den Kalender verwendet.

So synchronisieren Sie Datum und Uhrzeit mit 
dem Netz:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & Datum 
> Uhrzeit Auto-Update > Ein

So stellen Sie Datum und Uhrzeit manuell ein:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & Datum 
> Uhrzeit Auto-Update > Aus, anschließend > Zeit und Datum

Zum Einstellen der Uhrzeit und des Datums drücken 
Sie S links/rechts, um zu einer Einstellung zu blättern. 
Drücken Sie anschließend S oben/unten, um die 
Einstellung zu ändern. Drücken Sie Einstellen, um die 
Einstellungen zu speichern.
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So zeigen Sie im Standby-Display die digitale Uhrzeit 
im 12-Stunden- oder 24-Stunden-Format an:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & Datum 
> Uhrzeitformat > 12-Stunden-Format oder 24-Stunden-Format

So legen Sie das Datumsformat 
im Standby-Display fest:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & Datum 
> Datumsformat

So legen Sie die Zeitzone fest:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & Datum 
> Zeitzone, wählen Sie anschließend einen Ort in Ihrer 
Zeitzone.

Schnellzugriff: Geben Sie über die Buchstabentasten 
die ersten Buchstaben des gesuchten Orts ein.

Themes
Mit einem Telefon-Theme können Sie das 
Aussehen und den Sound Ihres Telefons 
personalisieren. Meistens umfassen Themes ein 
Wallpaper, einen Screensaver und einen Signalton.

So aktivieren Sie ein Theme:

Zu finden unter: s > u Setup > Themes > Theme

Sie können im Standby-Display auch Optionen 
> Standby-Display anpassen > Theme ändern drücken.

Informationen zum Herunterladen von Themes finden 
Sie auf Seite 54.

So löschen Sie ein Theme:

Zu finden unter: s > u Setup > Themes, blättern 
Sie zum Theme, und drücken Sie Optionen > Verwalten 
> Löschen.
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Hinweis: Sie können nur heruntergeladene Themes 
oder benutzerdefinierte Themes, die Sie erstellt haben, 
löschen.

Theme ändern
Zu finden unter: s > u Setup > Themes, blättern Sie 
zum Theme, drücken Sie Optionen > Bearbeiten.
  1 Drücken Sie S links/rechts, um die Registerkarte 

Sounds [ oder Bilder $ auszuwählen.

2 Drücken Sie S oben/unten, um zur Einstellung 
zu blättern, die Sie ändern möchten. Drücken Sie 
dann s.

3 Blättern Sie zur gewünschten Bild- oder 
Sounddatei, und wählen Sie sie aus.

4 Drücken Sie Speichern, um die Änderungen am 
Theme zu speichern und das Menü zu beenden.

Das Wallpaper wird als Hintergrundbild auf dem 
Standby-Display angezeigt.

Der Screensaver wird aktiviert, wenn über einen 
festgelegten Zeitraum keine Aktivität festgestellt wurde. 
Informationen zum Einstellen des 
Verzögerungsintervalls finden Sie im folgenden 
Abschnitt.

Mit Skins ändern Sie das Erscheinungsbild des 
Telefondisplays.

So führen Sie das Zurücksetzen auf 
Standardeinstellungen für ein geändertes Theme aus:

Zu finden unter: s > u Setup > Themes > Theme, 
drücken Sie Optionen > Verwalten > Zurücksetzen.

Neues Theme erstellen
Zu finden unter: s > u Setup > Themes, drücken Sie 
Optionen > Neu erstellen oder Kopie erstellen.
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Displayeinstellungen
So stellen Sie die Helligkeit des Displays ein:

Zu finden unter: s > u Setup > Telefon > Display 
> Helligkeit

Wenn Sie Ihr Mobiltelefon nicht verwenden, kann die 
Beleuchtung des Tastenfelds zur Verlängerung der 
Akkulaufzeit automatisch ausgeschaltet werden. 
So legen Sie das Verzögerungsintervall für das 
Deaktivieren der Hintergrundbeleuchtung fest:

Zu finden unter: s > u Setup > Telefon > Display 
> Timeout

Um die Akkulaufzeit zu verlängern, wird das Display 
automatisch ausgeschaltet, wenn über einen 
bestimmten Zeitraum keine Aktivität erfolgt. So legen 
Sie das Verzögerungsintervall für das Deaktivieren 
des Displays fest:

Zu finden unter: s > u Setup > Telefon > Display 
> Timeout Display

So legen Sie das Verzögerungsintervall für 
das Deaktivieren des Screensaver fest:

Zu finden unter: s > u Setup > Telefon > Display 
> Timeout Screensaver

Hinweis: Um den Screensaver anzuzeigen, muss die 
Einstellung Timeout Display größer als die Einstellung 
Timeout Screensaver sein.

Tipp: Zur Verlängerung der Akkulaufzeit empfiehlt es 
sich, den Screensaver zu deaktivieren.
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Rufannahme
Sie können einen eingehenden Anruf auf verschiedene 
Arten annehmen. So aktivieren bzw. deaktivieren Sie 
eine Annahmeoption:

Zu finden unter: s > u Setup > Anrufe 
> Gesprächsoptionen > Rufannahme

Sie können immer N drücken, um einen Anruf 
anzunehmen.

Optionen

Taste drücken

Annahme durch Drücken einer beliebigen Taste.

Klappe öffnen

Annahme durch Öffnen der Telefonklappe.
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Anrufe

Abschalten 
des Anrufsignals
Drücken Sie die externen Lautstärketasten seitlich 
am Telefon, um den Klingelton abzuschalten, 
bevor Sie einen Anruf entgegennehmen.

Anrufliste
Das Mobiltelefon verwaltet Listen der ein- und 
ausgehenden Anrufe, auch wenn bei diesen Anrufen 
kein Gespräch zustande kam. Die Liste beginnt mit den 
neuesten Anrufen. Die jeweils ältesten Anrufe werden 
gelöscht, wenn neue hinzukommen.

Schnellzugriff: Drücken Sie im Standby-Display N, 
um Gewählte Anrufe anzuzeigen.

Zu finden unter: s > q Anrufliste, drücken Sie #, 
um die Liste Gewählte Anrufe, Entgangene Anrufe, 
Beantwortete Anrufe oder Anrufliste auszuwählen.

Blättern Sie zu einem Anruf. Anhand der Symbole 
erkennen Sie, ob ein Anruf eingegangen ist +, 
abgegangen ist  -, oder verpasst wurde =. 
Ein Häkchen neben einem Symbol bedeutet, 
dass ein Anruf verbunden ist.

• Drücken Sie zum Anrufen dieser 
Telefonnummer N.

• Zum Anzeigen von Detailinformationen 
(z. B. Datum und Uhrzeit) zu diesem Anruf 
drücken Sie s.
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• Drücken Sie Optionen, um Optionen für die 
letzten Anrufe oder um Anrufdauer oder 
Anrufkosten auszuwählen (siehe Seite 86).

Wahlwiederholung
  1 Drücken Sie im Standby-Display N, um die Liste 

Gewählte Anrufe anzuzeigen.

2 Blättern Sie zu der Nummer, die Sie anrufen 
möchten, und drücken Sie N.

Wenn Sie ein Besetztzeichen hören und 
Anruf gescheitert angezeigt wird, drücken Sie N 
oder Erneut versuchen, um die Nummer erneut zu wählen. 
Beim Durchstellen des Anrufs wird die Meldung 
Verbunden angezeigt.

Zurückrufen
Das Mobiltelefon erfasst unbeantwortete Anrufe und 
zeigt die Meldung x entgangene(r) Anruf(e) an. Dabei 
bezeichnet x die Anzahl dieser Anrufe.
  1 Wenn die Nachricht x entgangene(r) Anruf(e) angezeigt 

wird, drücken Sie s, um die Liste Entgangene Anrufe 
anzuzeigen. Blättern Sie zu dem Eintrag, den Sie 
zurückrufen möchten, und drücken Sie N.

Anrufer-Display
Mit der Anrufer-Identifizierung (Anrufer-ID) wird 
die Rufnummer eines eingehenden Anrufs auf 
dem Display des Telefons angezeigt.

Ihr Telefon zeigt Name und Bild des Anrufers an, wenn 
diese in der Kontaktliste gespeichert sind. Falls keine 
Anruferkennung übertragen wird, wird im Display die 
Nachricht Eingeh. Anruf... angezeigt.
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Hinweis: Bild-IDs sind für auf der SIM-Karte 
gespeicherte Kontakte nicht verfügbar.

Tipp: Möchten Sie den Anrufer schon am Klingelton 
erkennen? Informationen zum Zuweisen eines 
speziellen Klingeltons für einen Kontakt finden Sie auf 
Seite 81.

Um Ihre Rufnummer beim nächsten abgehenden Anruf 
anzuzeigen bzw. zu unterdrücken, geben Sie die 
Rufnummer ein, die Sie wählen möchten, und drücken 
dann Optionen > ID anzeigen oder ID verbergen.

So übermitteln oder unterdrücken Sie Ihre Rufnummer 
für alle Anrufe:

Zu finden unter: s > u Setup > Anrufe 
> Gesprächsoptionen > Meine Anrufer-ID > Alle Anrufe 
> ID übermitteln oder ID verbergen

Notrufe
Ihr Diensteanbieter programmiert eine oder mehrere 
Notrufnummern (beispielsweise 911 oder 112), sodass 
Sie diese jederzeit anrufen können, auch wenn das 
Telefon gesperrt oder keine SIM-Karte eingelegt ist.

Hinweis: Überprüfen Sie dies bei Ihrem 
Diensteanbieter, da die Notrufnummern 
länderabhängig sind. Das Telefon funktioniert u. U. 
nicht überall. Das Absetzen eines Notrufs kann ggf. 
durch Netzprobleme, Umwelteinflüsse oder 
Interferenzen verhindert werden. Verlassen Sie sich 
bei erforderlichen Anrufen (z. B. medizinische Notfälle) 
nicht ausschließlich auf Ihr Mobiltelefon.

So tätigen Sie einen Notruf: Schalten Sie das Telefon 
ein, wählen Sie die Notrufnummer, und drücken Sie 
anschließend die Sendetaste, um die Notrufnummer 
anzurufen.
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Sprachnachrichten
Empfangene Sprachnachrichten werden in Ihrer 
Mailbox gespeichert. Zum Abhören der 
Nachrichten rufen Sie Ihre Mailbox an.

Hinweis: Von Ihrem Diensteanbieter erhalten Sie ggf. 
weitere Informationen zur Nutzung dieser Funktion.

Wenn Sie eine Sprachnachricht erhalten, werden 
im Telefondisplay Neue Sprachnachricht und das 
Sprachnachrichtensymbol U angezeigt.

Abhören der Sprachnachrichten:

s > g Nachrichten > Mailbox anrufen

Schnellzugriff: Ihr Diensteanbieter hat möglicherweise 
Ihre Mailbox-Nummer unter der Kurzwahltaste 
1 abgelegt. Ist dies der Fall, halten Sie im 
Standby-Display 1 gedrückt, und hören 
Sie die Mailbox-Nachricht(en) ab.
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Unterhaltung

Musik-Player
Anleitungen zum Musik-Player finden Sie im Handbuch 
ERSTE INFORMATIONEN.

Standardformat und Bitrate für 
Windows Media Player 11 festlegen
Windows Media Player 11 ermöglicht Ihnen das 
Anpassen der Format- und Bitrateneinstellungen zur 
Optimierung der Tonqualität oder Erhöhung der Anzahl 
Lieder, die Sie auf dem Mobiltelefon speichern können.

Das Windows Media Audio-Format ermöglicht das 
optimale Gleichgewicht zwischen Dateigröße und 
Tonqualität. Songdateien in diesem Format benötigen 
mehr Speicherplatz als Dateien im Windows Media 
Audio Pro-Format.

Das Windows Media Audio Pro-Format wurde für die 
Verwendung in tragbaren Geräten mit begrenzter 
Speicherkapazität konzipiert. Das Format bietet eine 
verbesserte Tonqualität zu geringeren Bitraten.

So legen Sie das Standarddateiformat und die Bitrate 
fest:
  1 Legen Sie die Musik-CD in das CD-Laufwerk 

des Computers ein.

2 Starten Sie Windows Media Player 11.

3 Wählen Sie in Windows Media Player 11 
die Registerkarte „Von Medium kopieren“.
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4 Klicken Sie auf der Registerkarte „Von Medium 
kopieren“ auf den Pfeil nach unten, und wählen 
Sie Format > Windows Media Audio oder 
Windows Media Audio Pro.

5 Klicken Sie erneut auf der Registerkarte „Von 
Medium kopieren“ auf den Pfeil nach unten, 
und wählen Sie Bitrate > Bitrate.

iTunes AAC-Dateien in 
MP3-Dateien auf dem Computer 
umwandeln:
Verwenden Sie die iTunes-Desktopanwendung, um 
iTunes-AAC-Standarddateien in MP3-Dateien 
umzuwandeln, die mit Windows Media Player 11 
kompatibel sind.

Hinweis: Mit der iTunes-Desktopanwendung können 
Sie nur AAC-Dateien umwandeln, die von einer 
Musik-CD gerippt wurden. Sie können mit dieser 
Anwendung keine Musikdateien umwandeln, 
die Sie über den iTunes Store erworben haben.

  1 Starten Sie die iTunes-Desktopanwendung auf 
dem Computer.

2 Wählen Sie Bearbeiten > Einstellungen, klicken 
Sie auf die Registerkarte „Erweitert“, und klicken 
Sie auf „Importieren“.

3 Öffnen Sie das Popup-Menü „Importieren mit“, 
und wählen Sie die Option „MP3-Codierer“. 
Klicken Sie auf OK, um die Einstellungen zu 
speichern.

4 Wählen Sie mindestens ein Lied in der 
iTunes-Musikbibliothek. Wählen Sie anschließend 
Erweitert > Auswahl in MP3 konvertieren.

Die umgewandelten MP3-Dateikopien werden in der 
Musikbibliothek des Computers zusammen mit den 
AAC-Originaldateien angezeigt.
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Musik abspielen (Klappe geöffnet)
Mit der Navigationstaste S steuern Sie die 
Wiedergabe der Musiktitel bei geöffneter 
Telefonklappe.

Drücken Sie während der Musikwiedergabe Optionen, 
um die Musik-Player-Optionen auszuwählen:

01:15 02:40

Drücken Sie
S zum

Abspielen
bzw.

Anhalten
(Pause) nach

oben und
zum Stoppen

nach unten.

Der Timer 
zeigt die 
bereits 
abgespielte 
Zeit in 
Prozent an.

Titel
Künstler
Album

Album
Cover

Zurück zum 
vorherigen 
Bildschirm.Drücken Sie

S links
oder rechts,

um zum
vorherigen

bzw.
nächsten

Titel zu
springen.

Musik-Player-Optionen 
auswählen und 
anpassen.

Titel
10/10/2008--910 Kb

ZurückOptionen

Optionen

Ausblenden

Musik-Player während der Wiedergabe ausblenden. 
Um den Musik-Player wieder einzublenden, drücken 
Sie im Standby-Display S oben.

Verwalten

Eigenschaften des Musiktitels, wie z. B. Dateiname, 
Typ und Größe, anzeigen.

Löschen

Musikdatei löschen.

Senden an

Musiktitel in einer Nachricht oder E-Mail senden oder 
über eine Bluetooth-Verbindung an ein anderes 
Gerät senden.
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Während der Musikwiedergabe zeigt der Musik-Player 
gegebenenfalls Musiktitel, Interpret, Album und Cover 
an. Um ein größeres Bild des Covers anzuzeigen, 
drücken Sie s (drücken Sie sie erneut, um zum 
Musik-Player zurückzukehren).

Musik-Player personalisieren
Zu finden unter: [, drücken Sie Optionen > Einrichten.

Verwendung

Musiktitel zu einer Playlist hinzufügen oder zu einem 
Klingelton konvertieren.

Bluetooth verwenden/ Mobilteil verwenden

Wenn Bluetooth aktiviert ist, wählen Sie 
Bluetooth verwenden, um die Audiofunktion an ein 
Bluetooth-Headset umzuleiten.

Wenn eine Bluetooth-Audioverbindung aktiv ist, 
wählen Sie Mobilteil verwenden, um den Ton wieder 
auf das Telefon umzuleiten.

Hinweis: Diese Option wird nur dann angezeigt, 
wenn Bluetooth aktiviert ist.

Einrichten

Kameraeinstellungen personalisieren.

Optionen
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Sie können folgende Optionen auswählen:

Wenn Sie zu einem Song in einer Liste blättern und 
Optionen drücken, werden möglicherweise zusätzliche 
Optionen für den Song und die Liste angezeigt, 
wie z. B. Löschen, Senden an und Verwendung.

Browser
Verwenden Sie den HTML-Browser des Telefons, 
um Ihre Websites aufzurufen, Videos auf ein Videoblog 
zu laden und Dateien und Anwendungen auf das 
Telefon herunterzuladen. Melden Sie sich bei Ihrem 
Internet-E-Mail-Konto an, um Ihre E-Mail unterwegs 
abzurufen.

So starten Sie den Browser:

Zu finden unter: s > 1 Web-Zugriff > Browser

Drücken Sie S oben, unten, links oder rechts, 
um durch die Webseiten zu blättern. Blättern Sie zu 
einem Link, und drücken Sie s, um ihn auszuwählen. 
Drücken Sie Zurück jederzeit, um zum vorherigen 
Bildschirm zurückzukehren.

Einige Webseiten können ein Texteingabefenster für 
den Austausch von Informationen mit einer Website 
enthalten. Blättern Sie zu einem Fenster, wählen Sie es 
aus, und geben Sie den Text wie gewohnt ein (weitere 
Informationen zur Texteingabe finden Sie auf Seite 28).

Optionen

Zufällige Wiedergab.

Musiktitel in einer zufälligen Reihenfolge 
wiedergeben.

Auto. Wiederholung

Den Musiktitel oder die Playlist erneut wiedergeben, 
sobald die Wiedergabe der letzten Datei beendet ist.

Stereoeffekte

Aktivieren Sie Raumklang und Bass Boost, um den 
Ton anzupassen.

Internetverbindung

Legen Sie Ihre 
Internet-Verbindungseinstellungen fest.
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Um eine Webseite aufzurufen, drücken Sie Optionen 
> URL aufrufen, geben die Internetadresse ein und 
drücken anschießend Start.

Um ein Lesezeichen in die aktuelle Webseite 
einzufügen, drücken Sie Optionen 
> Aktuelle Seite > Zu Lesezeichen hinzufügen.

Um eine Webseite mit einem Lesezeichen aufzurufen, 
drücken Sie Optionen > Meine Lesezeichen > Lesezeichen.

Informationen zum Hochladen eines Videos auf eine 
Blogsite finden Sie im Handbuch ERSTE 
INFORMATIONEN.

Zum Herunterladen einer Mediadatei, eines Themes 
oder eines Java™-Spiels bzw. -Anwendung auf Ihr 
Telefon, rufen Sie die Seite auf, die mit der Datei 
verknüpft ist, blättern zu dem Link, und wählen ihn aus.

Um den Browser zu beenden, drücken Sie Optionen 
> Beenden.

Kamera
Mit der 2-Megapixel-Digitalkamera des Telefons können 
Sie Fotos in einer Auflösung von bis zu 1200 x 1600 
Pixel aufnehmen. Richten Sie Ihr Mobiltelefon auf 
das Motiv, und nehmen Sie ein Foto auf. Drücken 
Sie anschließend Senden, um das Foto an Ihre Freunde 
zu senden.
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Foto aufnehmen
Zu finden unter: s > j Multimedia > Kamera

Drücken Sie s, um das Bild mit dem Kamerasucher 
einzufangen.

• Um das Foto zu speichern, drücken Sie s.

• Drücken Sie Senden, um das Foto in einer 
Nachricht zu versenden (siehe Seite 61).

• Um das Foto zu löschen, drücken Sie die 
Löschen-/Rücktaste D.

• Um weitere Fotooptionen auszuwählen, 
drücken Sie Optionen. Sie können folgende 
Optionen auswählen: Nur speichern, Löschen, 
Senden an (Nachricht, E-Mail oder 
Bluetooth-Verbindung), Verwendung (Wallpaper, 
Screensaver, neuer oder vorhandener Kontakt), 
Bearbeiten oder Drucken über (Bluetooth- oder 
USB-Verbindung).

370

Timer Speicherort 
(Telefonspeicher)

Zurück zum 
vorherigen 
Bildschirm.

Drücken
Sie S oben

oder unten,
um die

Kameraeinstel
lungen

anzuzeigen,
und nach

rechts oder
links, um die

Einstellungen
zu ändern.

Kameraoptionen
auswählen und 
anpassen.

ZurückOptionen

Kameramodu
s (Foto oder

Video)

Verbleibende Aufnahmen

Auflösung

Zoom x1
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Automatisches Senden
Sie können das Telefon so einrichten, dass die 
aufgenommenen Fotos an eine Liste von angegebenen 
Kontakten gesendet werden.

Um Fotos automatisch zu senden, müssen Sie zuerst 
die automatische Sendefunktion aktivieren.

Zu finden unter: s > j Multimedia > Kamera, drücken 
Sie Optionen > Kameraeinstellungen > Autom. Speichern 
> Aktivieren.

Aktivieren Sie dann das automatische Senden:

Zu finden unter: s > j Multimedia > Kamera, drücken 
Sie Optionen > Kameraeinstellungen > Automat. senden > Aktivieren.

So geben Sie die Nachrichtenempfänger für die 
aufgenommenen Fotos an:

Zu finden unter: s > j Multimedia > Kamera, drücken 
Sie Optionen > Kameraeinstellungen > Nachrichtenempfänger.

Tipp: Um das Foto in einer MMS-Textnachricht zu 
senden, müssen Sie für die Bildauflösung die Option 

Extraklein, Klein oder Mittel einstellen. Um die Auflösung 
einzustellen, drücken Sie s > j Multimedia > Kamera 
und Optionen > Kameraeinstellungen > Bildeinstellungen 
> Auflösung.

Selbstporträt
Wenn der Sucher aktiv ist, können Sie die 
Telefonklappe schließen, um den Sucher auf dem 
externen Display anzuzeigen. Drücken Sie die seitliche 
Auswahltaste (siehe Abbildung auf Seite 3), um ein 
Foto aufzunehmen. Die aufgenommenen Fotos werden 
automatisch gespeichert, wenn die Telefonklappe 
geschlossen ist.
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Kameraeinstellungen
Drücken Sie bei aktiviertem Kamerasucher  Optionen, 
um die Kameraoptionen auszuwählen:

Video
Informationen zum Aufnehmen und zur Wiedergabe 
eines Videos und zum Hochladen eines Videos auf eine 
Videoblogsite finden Sie im Handbuch ERSTE 
INFORMATIONEN.

Optionen

Aufnahme

Foto aufnehmen.

Gehe zu My Media

Gespeicherte Bilder und Fotos anzeigen, bearbeiten 
und löschen.

Videomodus

Zur Videokamera umschalten.

Selbstauslöser

Aktivieren des Selbstauslösers.

Serienbild

Aktivieren der Kamera, um Serienfotos 
aufzunehmen.

Kameraeinstellungen

Kameraeinstellungen personalisieren: 

• Überprüfungszeit
• Verschlusston
• Standardname
• Autom. Speichern
• Automat. senden
• Nachrichtenempfänger
• Bildeinstellungen
• Videoeinstellungen

Optionen
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Optionen für die 
Videoaufzeichnung festlegen
Drücken Sie bei aktiviertem Kamerasucher Optionen, 
um die Optionen für die Videoaufnahme auszuwählen:

Optionen für die Videowiedergabe 
festlegen
Drücken Sie während der Videowiedergabe Optionen, 
um die Optionen für die Videowiedergabe 
auszuwählen.

Hinweis: Die Optionen Ihres Telefons können sich von 
den folgenden Optionen unterscheiden. Die meisten 
Optionen beziehen sich nur auf vom Benutzer 
aufgenommene Videos und stehen nicht für 
vorinstallierte Videos zur Verfügung.

Optionen

Aufnahme

Videoaufnahme starten.

Gehe zu My Media

Gespeicherte Videos anzeigen, bearbeiten und 
löschen.

Bildmodus

Zur Fotokamera umschalten.

Audio Ein/Audio Aus

Audioaufnahme aktivieren/deaktivieren.

Kameraeinstellungen

Kameraeinstellungen anpassen (siehe Seite 58).

Optionen

Vollbild

Video auf dem gesamten Bildschirm anzeigen. 
(Drücken Sie s, um zur tatsächlichen Größe 
zurückzukehren.)

Verwalten

Eigenschaften eines Videos anzeigen, wie z. B. 
Dateiname, Format und Größe.
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Löschen

Video löschen.

Zoom

Video in der tatsächlichen Größe anzeigen oder 
Videobild auf den gesamten Bildschirm vergrößern.

Senden an

Video in einer Nachricht oder E-Mail oder über eine 
Bluetooth-Verbindung an ein anderes Gerät senden.

Optionen

Bluetooth verwenden/Mobilteil verwenden

Wenn Bluetooth aktiviert ist, wählen Sie 
Bluetooth verwenden, um den Ton (falls verfügbar) 
an ein Bluetooth-Headset umzuleiten.

Wenn eine Bluetooth-Audioverbindung aktiv ist, 
wählen Sie Mobilteil verwenden, um den Ton wieder 
auf das Telefon umzuleiten.

Hinweis: Diese Option wird nur dann angezeigt, 
wenn Bluetooth aktiviert ist.

Einrichten

Videoeinstellungen anpassen.

Optionen
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Nachrichten

Nachricht senden
Eine Nachricht kann Text, Bilder, Sounds oder 
andere Mediadateien enthalten. Sie können 
mehrere Seiten in eine Nachricht einfügen und Text 
oder Objekte auf jeder Seite platzieren. Die Nachricht 
kann an kompatible Telefone oder E-Mail-Adressen 
gesendet werden.
 Zu finden unter: s > g Nachrichten > Nachricht erstellen
 1 Geben Sie den Text ein (weitere Informationen 

zur Texteingabe finden Sie auf Seite 28).

Um ein Bild-, Ton- oder andere Mediadatei 
einzufügen, drücken Sie Optionen > Einfügen. 
Wählen Sie den Dateityp und die Datei.

(Hinweis: Möglicherweise gelten für Bilder 
und Videos, die Sie in einer Nachricht senden, 
Dateigrößenbeschränkungen.)

Um eine neue Seite hinzuzufügen, drücken 
Sie Optionen > Einfügen > Seite.

2 Drücken Sie nach Fertigstellen der Nachricht 
Optionen > Sendeoptionen, um die Nachrichtenoptionen 
einzustellen (beispielsweise Betreff und Priorität).

3 Nachdem Sie die gewünschten 
Nachrichtenoptionen festgelegt haben, 
drücken Sie Fertig.
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4 Drücken Sie Senden an, um die Empfänger der 
Nachricht auszuwählen. Sie haben folgende 
Möglichkeiten:

• Wählen Sie einen oder mehrere Einträge aus 
der Kontaktliste aus (drücken Sie S, um zu 
einem Eintrag zu blättern, und drücken Sie die 
mittlere Taste s, um den Eintrag auszuwählen).

• Geben Sie eine neue Nummer oder 
E-Mail-Adresse ein (drücken Sie Optionen 
> Rufnummer eingeben oder E-Mail eingeben).

5 Drücken Sie Senden zum Senden der Nachricht.

Möglicherweise erhalten Sie die Meldung, dass 
es sich um eine Multimedia- bzw. MMS-Nachricht 
handelt, wenn mehrere Seiten oder Mediadateien 
vorhanden sind. Nicht alle Telefone oder Netze 
unterstützen MMS-Nachrichten. Drücken Sie 
Ja zum Senden der Nachricht.

Um die Nachricht zu speichern oder abzubrechen, 
drücken Sie Optionen > In Entwürfe speichern oder 
Nachricht abbrechen.

Nachricht empfangen
Wenn Sie eine Nachricht erhalten, ertönt ein 
Hinweiston, und das Display zeigt Neue Nachricht 
mit einem Nachrichtensymbol (wie zum 
Beispiel ]) an.

Drücken Sie Anzeigen zum Lesen der Nachricht. Nachricht 
mit Mediadateien:

• Beim Lesen der Nachricht werden Bilder 
und Animationen angezeigt.

• Beim Lesen der Nachricht werden 
Sounddateien wiedergegeben. Drücken Sie 
die externen Lautstärketasten seitlich am 
Telefon, um die Lautstärke zu ändern.

• Angehängte Dateien befinden sich am Ende 
der Nachricht. Um einen Anhang zu öffnen, 
wählen Sie das Dateisymbol oder den 
Dateinamen aus.

Um die Nachricht zu beantworten, drücken Sie Optionen 
> Antworten.
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Zusätzliche Nachrichten- 
und E-Mail-Funktionen

Funktionen

Textvorlage senden

s > g Nachrichten > Vorlagen > Textvorlagen 
> Vorlage, drücken Sie Optionen > Senden.

So erstellen Sie eine neue Textvorlage:

s > g Nachrichten > Vorlagen > Textvorlagen, drücken 
Sie Optionen > Vorlage erstellen.

E-Mail-Konten einrichten

Mehrere E-Mail-Konten im Telefon einrichten 
und verwenden:

s > g Nachrichten > E-Mail > Konto hinzufügen

Hinweis: Das Display zeigt einen separaten Ordner 
für jedes E-Mail-Konto an.

E-Mail senden

s > g Nachrichten > E-Mail

MMS-Vorlage verwenden

MMS-Vorlage mit vorinstallierten 
Mediadateien, z. B. Bild, öffnen:

s > g Nachrichten > Vorlagen > MMS-Vorlagen

Neue Nachricht oder E-Mail lesen

Wenn die Meldung Neue Nachricht angezeigt 
wird, drücken Sie Lesen.

Nachrichten lesen

s > g Nachrichten > Posteingang

Symbole neben den einzelnen Nachrichten 
kennzeichnen deren Status: gelesen >, ungelesen 
], dringend < oder mit Anhang *. Die Taste 
Optionen bietet weitere Möglichkeiten zur Bearbeitung 
von E-Mails.

Funktionen
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E-Mails lesen

s > g Nachrichten > E-Mail

Die Taste Optionen bietet weitere Möglichkeiten zur 
Bearbeitung von E-Mails.

Nachrichtenobjekte speichern

Öffnen Sie die Seite einer MMS-Nachricht, 
und drücken Sie Optionen > Speichern.

Ordner erstellen

Erstellen Sie einen persönlichen Ordner für 
das Speichern Ihrer Nachrichten.

s > g Nachrichten > Meine Ordner, drücken Sie Optionen 
> Ordner erstellen.

Funktionen

Browser-Nachrichten

Mit dem Browser empfangene Nachrichten 
lesen:

Wenn die Meldung Neue Nachricht angezeigt wird, 
drücken Sie Anzeigen.

So aktivieren Sie Browser-Nachrichten und passen 
die Einstellungen für Browser-Nachrichten an:

s > g Nachrichten, drücken Sie Optionen > Einstellungen 
> Browser-Nachricht..

Funktionen
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Instant Messaging
Mit Instant Messaging können Sie Nachrichten in 
Echtzeit mit Ihren Freunden austauschen.

Zu finden unter: s > m Tools > IM, blättern Sie zu 
Ihrem IM-Konto, drücken Sie Login.

Wenn Sie nicht über ein IM-Konto verfügen, wählen Sie 
Neues Konto, um ein Konto zu erstellen.

Um andere Benutzer online zu finden, wählen Sie 
Kontaktliste, um eine Liste mit anderen Benutzern 
anzuzeigen.

Um ein Gespräch zu starten, blättern Sie in der Liste 
Online-Kontak. suchen zu einem Namen und drücken IM senden.

Um ein aktives Gespräch zu öffnen, blättern Sie in der 
Liste Gespräche zu einem Namen und drücken Anzeigen.

Um ein Gespräch zu beenden, drücken Sie Optionen 
> Gespräch beenden.

Um sich bei der Instant Messaging-Sitzung 
abzumelden, drücken Sie Optionen > Abmelden.

Cell Broadcast

Abonnierte Cell Broadcast-Nachrichten 
anzeigen:

Wenn die Meldung Neue Nachricht angezeigt wird, 
drücken Sie Anzeigen.

So aktivieren Sie Cell Broadcast und passen die 
Einstellungen hierfür an:

s > g Nachrichten, drücken Sie Optionen > Einstellungen 
> Cell Broadcast.

Funktionen
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IM-Accounts erstellen oder 
bearbeiten
So erstellen Sie ein neues IM-Konto:

Zu finden unter: s > m Tools > IM > Neues Konto

So bearbeiten Sie ein vorhandenes IM-Konto:

Zu finden unter: s > m Tools > IM, blättern Sie zu 
einem Konto, drücken Sie Optionen > Konto bearbeiten.
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Verbindungen

MOTOSYNC
Zum Synchronisieren von Informationen 
zwischen Ihrem Telefon und einem 
Remote-Server stehen Ihnen verschiedene 
Funkverbindungsmethoden zur Verfügung.

MOTOSYNC mit Exchange 
ActiveSync
Sie können die Kontaktliste, Kalendereinträge 
und E-Mail des Telefons über das Internet 
synchronisieren. Dazu benötigen Sie ein E-Mail-Konto 
auf einem Microsoft® Exchange 2003-Server.

Exchange ActiveSync einrichten
Stellen Sie sicher, dass die Mobility-Option für das 
E-Mail-Konto und der Datendienst bei Ihrem 

Diensteanbieter aktiviert ist (für diesen Dienst können 
zusätzliche Gebühren anfallen).

So richten Sie einen ActiveSync-Partner ein:

Zu finden unter: s > m Tools > MOTOSYNC 
> Exchange ActiveSync

Geben Sie die Informationen für Ihr E-Mail-Konto und 
den Server ein, einschließlich Benutzername, Passwort, 
Domänenname, Servername und Datenverbindung. Wenden Sie 
sich gegebenenfalls an Ihren IT-Systemadministrator, 
um die erforderlichen Informationen oder Hilfe zum 
Verbinden des Telefons mit dem Server zu erhalten.
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Exchange ActiveSync verwenden
Automatische Synchronisierung von Daten mit einem 
Exchange ActiveSync-Partner planen:

Zu finden unter: s > m Tools > MOTOSYNC 
> Exchange ActiveSync, drücken Sie Optionen > Auto-Sync > Ein 
und OK, um die Uhrzeit und die Tage für die 
Synchronisierung einzugeben.

So synchronisieren Sie Kontakte, Kalendereinträge und 
E-Mail manuell:

Zu finden unter: s > m Tools > MOTOSYNC 
> Exchange ActiveSync > Jetzt synchronisieren

Die erste Synchronisierung kann einige Minuten 
dauern. Dies hängt von der Datenmenge in der 
Kontaktliste im Kalender und in der E-Mail auf dem 
Exchange 2003-Server ab.

MOTOSYNC mit SyncML
Sie können einen SyncML-Internet-Server 
anrufen und die Kontaktliste und 
Kalendereinträge mit dem Server synchronisieren.

So synchronisieren Sie Dateien mit einem von Ihnen 
eingerichteten Partner:

Zu finden unter: s > m Tools > MOTOSYNC > SyncML

Wenn kein SyncML-Profil auf dem Telefon gespeichert 
ist, werden Sie aufgefordert, ein Profil zu erstellen. 
Wenden Sie sich an Ihren IT-Systemadministrator, 
um die erforderlichen Informationen für das Einrichten 
eines Profils zu erhalten.

Hinweis: Wenn das Telefon keine Verbindung zum 
Server herstellen kann, vergewissern Sie sich, ob der 
Diensteanbieter Ihres Telefonnetzes den Datendienst 
für Ihr Telefon aktiviert hat (möglicherweise fällt für 
diesen Service eine zusätzliche Gebühr an).
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Datei-Manager
Verwalten Sie Musik-, Foto- und andere 
Multimedia-Dateien, die auf dem Telefon 
gespeichert sind.

Zu finden unter: s > m Tools > Datei-Manager

Wählen Sie einen Ordner aus, um den Inhalt 
anzuzeigen.

Um ein Foto oder ein Video anzuzeigen oder eine 
Sounddatei wiederzugeben, blättern Sie zur 
gewünschten Datei und wählen sie aus.

Zum Bearbeiten einer Datei blättern Sie zu der Datei 
und drücken dann Optionen, um die Datei zu löschen, 
umzubenennen, zu kopieren, zu verschieben, zu 
senden oder anzuwenden. Einige Operationen können 
nicht für bestimmte urheberrechtlich geschützte oder 
vorinstallierte Dateien ausgeführt werden.

Zum Kopieren von Dateien zwischen dem Telefon und 
einem Computer können Sie eine Kabelverbindung 

(siehe nächsten Abschnitt) oder eine 
Bluetooth-Verbindung (siehe Seite 72) verwenden.

Kabelverbindungen 
Um Daten 
zwischen dem 

Telefon und einem 
Computer zu übertragen, 
schließen Sie den 
Micro-USB-Stecker eines 
USB-Kabels an den Micro-USB-Anschluss des Telefons 
an. Schließen Sie das andere Ende des Kabels an den 
Computer an.

Hinweis: Ein Motorola Original-USB-Kabel 
und die zugehörige Software sind ggf. im 
Lieferumfang des Telefons enthalten. 
Dieses Zubehör ist auch separat erhältlich. 
Überprüfen Sie Ihren Computer auf den 
erforderlichen Kabeltyp.
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So verwenden Sie das Telefon als Modem: Drücken Sie 
s > u Setup > Verbindungen > USB-Einstellung > Modem.

So übertragen Sie Kontaktlisten und Kalendereinträge 
zwischen Telefon und Computer: Verwenden Sie die 
Modemverbindungseinstellungen auf dem Telefon 
(drücken Sie s > u Setup > Verbindungen 
> USB-Einstellung > Modem). Führen Sie hierzu die als 
Zubehör erhältliche Anwendung Motorola Phone Tools 
auf Ihrem Computer aus. Weitere Informationen finden 
Sie in der Bedienungsanleitung der Phone Tools.

So führen Sie Datenanrufe mittels eines 
angeschlossenen Computers aus: Verwenden Sie die 
Modemverbindungseinstellungen auf dem Telefon 
(drücken Sie s > u Setup > Verbindungen 
> USB-Einstellung > Modem). Sie können den Anruf über die 
Computeranwendung tätigen oder annehmen.

Um eine neue Datenverbindung auf dem Telefon 
herzustellen, drücken Sie s > u Setup > Verbindungen 
> Datenverbindungen > Neue Verbindung.

Informationen zum Kopieren von Dateien zwischen 
Telefon und Computer finden Sie im Handbuch ERSTE 
INFORMATIONEN im Abschnitt über das Kopieren von 
Musikdateien auf das Telefon.

So drucken Sie ein Bild über eine 
USB-PictBridge-Verbindung: Schließen Sie das Telefon 
an einen PictBridge-kompatiblen Drucker an, und 
verwenden Sie die Druckverbindungseinstellung des 
Telefons (drücken Sie s > u Setup > Verbindungen 
> USB-Einstellung > USB-Druck). Wählen Sie die zu 
druckenden Bilder aus, und drücken Sie Optionen 
> Drucken über > USB.

Bluetooth®- 
Verbindungen
Ihr Mobiltelefon unterstützt Bluetooth Sie 
können Ihr Mobiltelefon mit einem optionalen 
Bluetooth-Headset oder einem 
Bluetooth-Autoeinbausatz (Freisprechen) verbinden. 
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Sie können auch Bluetooth-Stereokopfhörer 
anschließen, um Musik zu hören, oder einen Computer 
anschließen, der Bluetooth-Verbindungen unterstützt, 
um Dateien auszutauschen, oder Sie können einen 
Drucker anschließen, der Bluetooth-Verbindungen 
unterstützt, um Bilder zu drucken. Sie können das 
Mobiltelefon auch als drahtloses Bluetooth-Modem 
verwenden, um eine Verbindung zum Internet 
herzustellen.

Um die Bluetooth-Funktion mit einem Höchstmaß 
an Sicherheit zu nutzen, sollten die 
Bluetooth-Geräte immer in einer sicheren, 
privaten Umgebung gekoppelt werden.

Bluetooth-Funktion des 
Mobiltelefons aktivieren oder 
deaktivieren
Die Bluetooth-Funktion des Telefons wird 
automatisch aktiviert, wenn eine Bluetooth-Funktion 
verwendet wird.

So aktivieren oder deaktivieren Sie die 
Bluetooth-Funktion:

Zu finden unter: s > u Setup > Verbindungen 
> Bluetooth, drücken Sie Optionen > Verwalten > Bluetooth-Setup 
> Bluetooth-Power > Ein.

Hinweis: Um die Akkulaufzeit zu erhöhen und die 
Bluetooth-Sicherheit zu maximieren, stellen Sie 
Bluetooth immer auf Aus, wenn Sie diese Funktion 
nicht verwenden. Ihr Mobiltelefon wird solange 
keine Verbindung mit einem anderen Gerät herstellen, 
bis Sie erneut eine Bluetooth-Funktion verwenden oder 
Bluetooth wieder auf Ein stellen.

Bluetooth-Headset oder 
-Autoeinbausatz verwenden
Bevor Sie versuchen, das Mobiltelefon mit einer 
Freisprecheinrichtung zu verbinden, stellen Sie sicher, 
dass das Gerät eingeschaltet und betriebsbereit ist 
und sich im Koppelmodus bzw. Verbindungsmodus 
befindet (siehe Bedienungsanleitung für das jeweilige 
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Gerät). Sie können das Telefon jeweils nur an ein Gerät 
anschließen.

Zu finden unter: s > u Setup > Verbindungen 
> Bluetooth, drücken Sie Optionen > Gerät suchen > Headset.

Das Telefon listet die Geräte auf, die es innerhalb seiner 
Reichweite findet.
  1 Blättern Sie zu einem Gerät in der Liste.

2 Drücken Sie s, um eine Verbindung mit dem 
hervorgehoben angezeigten Gerät herzustellen.

Dateien zu einem anderen Gerät 
kopieren
Sie können eine Mediadatei, einen Kontakt, einen 
Kalendertermin oder ein Lesezeichen auf ein anderes 
Telefon oder einen Computer kopieren, sofern diese 
Bluetooth unterstützen.

Hinweis: Bestimmte mit einem Kopierschutz versehene 
Objekte können nicht kopiert werden.

Bevor Sie eine Datei auf ein anderes Gerät kopieren 
können, muss das Empfangsgerät eingeschaltet 
und erkennbar sein. Vergewissern Sie sich außerdem, 
dass zu dem Gerät keine andere aktive 
Bluetooth-Verbindung besteht.
  1 Blättern Sie im Telefon zu dem Objekt, das Sie 

auf das andere Gerät kopieren möchten.

2 Drücken Sie Optionen. Wählen Sie dann:

• Senden an > Bluetooth für eine Bild- oder 
Sounddatei.

• Kontakt senden via > Bluetooth für einen Kontakt.

• Termin mitteilen via > Bluetooth für einen 
Kalendereintrag.

• Sende Anfrage. Bitte warten > Bluetooth 
für ein Lesezeichen.



73Verbindungen

3 Wählen Sie ein erkanntes Gerät aus.

oder

Wählen Sie [Geräte suchen], um nach neuen Geräten 
zu suchen. Wählen Sie anschließend das Gerät, auf 
das Sie das Objekt kopieren möchten.

4 Drücken Sie ggf. nochmals Optionen > Senden.

5 Falls erforderlich geben Sie den Passkey des 
Geräts ein (z. B. 0000) und drücken OK, um das Gerät 
zu verbinden.

Dateien von einem anderen 
Gerät empfangen
Bevor Sie eine Datei von einem anderen Gerät 
empfangen, sollten Sie überprüfen, ob die 
Bluetooth-Funktion Ihres Mobiltelefons eingeschaltet 
ist (siehe Seite 71).

Bringen Sie das Mobiltelefon in die Nähe des Geräts, 
und senden Sie die Datei vom Gerät aus.

Wenn zwischen dem Mobiltelefon und dem sendenden 
Gerät bisher noch keine Koppelung durchgeführt 
wurde, versetzen Sie das Mobiltelefon in den 
Erkennungsmodus, damit das sendende Gerät das 
Mobiltelefon erkennen kann (drücken Sie s > u 
Setup > Verbindungen > Bluetooth und Optionen > Auffindbar). 
Das Bluetooth-Symbol & im Standby-Display blinkt, 
wenn sich das Telefon im Erkennungsmodus befindet.

Das Telefon benachrichtigt Sie, sobald die 
Dateiübertragung abgeschlossen ist, und die Datei wird 
gespeichert.

Foto an einen Drucker senden
Sie können ein Foto an einen Drucker senden, der 
Bluetooth-Verbindungen unterstützt.

Hinweis: Sie können Seiten im Format A4, US Letter 
und 4 x 6 drucken. Wenn Sie in anderen Formaten 
drucken möchten, müssen Sie das Bild auf einen 
verbundenen Computer kopieren und über diesen 
ausdrucken.
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  6 Nehmen Sie ein Bild mit dem Mobiltelefon auf, 
oder blättern Sie zu einem gespeicherten Bild, das 
Sie drucken möchten, und drücken Sie Optionen 
> Drucken über > Bluetooth.

Hinweis: Wird beim Versuch zu drucken die 
Meldung Unbekannter Dienst angezeigt, so wählen Sie 
stattdessen Senden an > Bluetooth. (Bei Verwendung 
der Option Senden an wird kein Bildname oder 
Zeitstempel gedruckt.)

7 Wählen Sie einen bekannten Druckernamen, 
oder wählen Sie [Suche nach Druckern], um nach einem 
anderen Drucker zu suchen, an den Sie das Bild 
senden möchten.

Hinweis: Wenn ein Drucker bereits in der Liste 
Drucker aufgeführt wird, drücken Sie s rechts, und 
wählen die Option Nach Drucker suchen, um nach einem 
anderen Drucker zu suchen.

8 Ändern Sie gegebenenfalls die Druckoptionen.

Weitere Bluetooth-Funktionen
Hinweis: Ein Gerät wird erkannt, nachdem es mit dem 
Mobiltelefon gekoppelt wurde (siehe Seite 72).

Funktionen

Koppeln mit einem erkannten Gerät.

Drücken Sie s > u Setup > Verbindungen 
> Bluetooth und S links/rechts, um die Liste 
Meine Geräte auszuwählen, drücken Sie S 
oben/unten, um zum Gerätenamen zu blättern. 
Drücken Sie dann s, um die Verbindung 
herzustellen.

Verbindung mit Gerät beenden

Blättern Sie zum gewünschten Gerätenamen, 
und drücken Sie Optionen > Verwalten > Gerät trennen.
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Mobiltelefon-Updates
Von Zeit zu Zeit verbessern wir die Software Ihres 
Mobiltelefons, um sie auch nach dem Kauf des Telefons 
schneller und effizienter zu gestalten. Unter folgender 
Adresse können Sie nach verfügbaren Updates 
suchen: www.hellomoto.com/update

Hinweis: Software-Updates wirken sich nicht auf die 
Kontaktliste oder andere persönliche Einträge oder 
Dateien aus. Wenn Sie empfangene Software-Updates 
später installieren wollen, finden Sie die erforderlichen 
Informationen auf Seite 88.

Gerät aus der Geräteliste entfernen

Blättern Sie zum gewünschten Gerätenamen, 
und drücken Sie Optionen > Verwalten > Gerät entfernen.

Hinweis: Ein Gerät kann nicht aus der Geräteliste 
entfernt werden, solange das Telefon mit diesem 
Gerät verbunden ist.

Während eines Anrufs die Audiofunktionen 
zum Bluetooth-Headset oder 
Bluetooth-Autoeinbausatz weiterleiten

Drücken Sie Optionen > Bluetooth verwenden.

Um den Ton wieder auf das Telefon umzuleiten, 
drücken Sie Optionen > Mobilteil verwenden.

Eigenschaften eines erkannten Geräts 
bearbeiten

Blättern Sie zum gewünschten Gerätenamen, und 
drücken Sie Optionen > Verwalten > Gerät bearbeiten.

Funktionen

Bluetooth-Optionen einstellen

Drücken Sie s > u Setup > Verbindungen 
> Bluetooth und Optionen > Verwalten > Bluetooth-Setup.

Funktionen
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Sonstige Funktionen

Erweiterte 
Anruffunktionen
Wie Sie zum Anrufen Sprachbefehle verwenden, finden 
Sie auf Seite 33.

Funktionen

Schnellwahl

Sie können neun Rufnummern im Telefon speichern, 
die Sie durch einen einzigen Tastendruck anrufen 
können. So speichern Sie eine Schnellwahlnummer:

s > u Setup > Anrufe > Schnellwahl 
> Kurzwahlspeicherort

Um eine Schnellwahlnummer anzurufen, halten Sie 
einfach die entsprechende Taste eine Sekunde lang 
gedrückt.

Auslandsgespräche

Zur Eingabe einer Rufnummer im Ausland 
(nur möglich, wenn Ihr Mobiltelefonvertrag 
Auslandsgespräche zulässt) halten Sie 0 gedrückt, 
um die Auslandsvorwahl (+) einzufügen. Wählen Sie 
dann die Ländervorwahl und die Rufnummer mithilfe 
der Zifferntasten.

Halten eines Anrufs

Zum Halten aller aktiven Gespräche drücken 
Sie Optionen > Halten.

Stummschalten eines Anrufs

Zum Stummschalten aller aktiven Gespräche 
drücken Sie Optionen > Stumm.

Funktionen
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Anklopfen

Wenn während eines laufenden Gesprächs 
ein weiterer Anruf eintrifft, werden Sie durch den 
Anklopfton auf diesen zweiten Anruf hingewiesen.

Drücken Sie zum Annehmen des neuen Anrufs N.

• Drücken Sie zum Wechseln zwischen den 
Gesprächen (Makeln) Wechseln.

• Drücken Sie zum Zusammenführen der 
beiden Gespräche Verbinden.

• Zum Beenden des gehaltenen Anrufs 
drücken Sie Optionen > Gehaltenen Anruf beenden.

So aktivieren oder deaktivieren Sie das Anklopfen:

s > u Setup > Anrufe > Gesprächsoptionen > Anklopfen 
> Ein oder Aus.

Funktionen

Weiteren Anruf während eines Anrufs 
tätigen

Während eines Anrufs:

Optionen > Neuer Anruf, drücken Sie Optionen 
> Kontakte durchsuchen.

Konferenzgespräch

Während eines Anrufs:

Wählen Sie die nächste Nummer, drücken Sie N 
und Optionen > Anrufe verbinden.

Weiterleiten eines Anrufs

Während eines Anrufs:

Optionen > Anrufübergabe, wählen Sie die Nummer, 
an die das Gesprächs weitergeleitet werden soll, 
und drücken Sie N.

Rufumleitung

Rufumleitung aktivieren oder deaktivieren:

s > u Setup > Anrufe > Anrufumleitung

Funktionen
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Anrufsperre

Einschränkungen für abgehende oder 
eingehende Anrufe festlegen:

s > u Setup > Anrufe > Anrufsperre

TTY-Anrufe

Richten Sie das Telefon für die Verwendung 
eines optionalen TTY-Geräts ein:

s > u Setup > Telefon > TTY-Einstellungen

Telefonleitung wechseln

Wenn Sie über eine SIM-Karte mit zwei 
Rufnummern verfügen, können Sie die Leitung 
wechseln, um über Ihre andere Rufnummer Anrufe 
zu tätigen und zu empfangen:

s > u Setup > Anrufe > Gesprächsoptionen 
> Aktive Leitung

Das Symbol für die aktive Leitung zeigt die aktive 
Telefonleitung an (siehe Abbildung auf Seite 27).

Funktionen

Feste Rufnummern

Wenn Sie diese Funktion aktivieren, können 
Sie nur die in der Liste der festen Rufnummern 
gespeicherten Nummern anrufen.

Hinweis: Um die Funktion für feste Rufnummern ein- 
oder auszuschalten, müssen Sie die den PIN2-Code 
Ihrer SIM-Karte eingeben. Setzen Sie sich mit dem 
Diensteanbieter in Verbindung, wenn Sie den 
PIN2-Code vergessen haben.

Aktivieren oder Deaktivieren der Funktion „Feste 
Rufnummern“:

s > u Setup > Anrufe > Feste Rufnummern > Ein 
oder Aus

Liste der festen Rufnummern verwenden:

s > m Tools > Wähldienste > Feste Rufnummern

Funktionen
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Kontakte
Die grundlegenden Funktionen der Kontaktliste finden 
Sie im Handbuch ERSTE INFORMATIONEN.

Service-Rufnummer

Vom Diensteanbieter gespeicherte 
Service-Rufnummern wählen:

s > m Tools > Wähldienste > Service-Rufnummer

MFV-Töne

MFV-Töne aktivieren:

s > u Setup > Anrufe > Gesprächsoptionen > DTMF

Während eines Anrufs MFV-Töne senden:

Drücken Sie die Zifferntasten.

Bindestriche

Telefon so konfigurieren, dass beim Eingeben von 
Rufnummern Bindestriche eingefügt werden:

s > u Setup > Anrufe > Gesprächsoptionen > Bindestrich

Funktionen

Funktionen

Neue Kontakte speichern

Hinweis: Sie können Kontakte im Telefonspeicher, 
im SIM-Kartenspeicher speichern. Auf der SIM-Karte 
gespeicherte Kontakte enthalten nur den Namen und 
die Rufnummer.

s > L Kontakte, drücken Sie Optionen > Ansicht 
> Telefon&SIM, SIM-Karte oder Telefonkontakte.

Die ausgewählte Ansicht bestimmt den Speicherort 
für neue Kontakte. Bei Ansicht "Telefon&SIM" können 
Sie den Speicherort auswählen.
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Neuen Kontakt hinzufügen

s > L Kontakte, drücken Sie Optionen > Neu erstellen.

Für neue, im Telefon gespeicherte Kontakte: Drücken 
Sie S links oder rechts, um die Registerkarte 
Kontaktdetails n, Adresse p, Bild-ID q, Signale 
m oder Notizen o auszuwählen. Drücken Sie S 
oben/unten, um zu den Informationen zu blättern, die 
Sie ändern möchten. Drücken Sie dann die mittlere 
Taste s, um die Informationen auszuwählen.

Kontaktlistenansicht festlegen

Im Telefonspeicher, im SIM-Kartenspeicher und in 
beiden Speichern gespeicherte Kontakte anzeigen:

s > L Kontakte, drücken Sie Optionen > Ansicht 
> Telefon & SIM, SIM-Karte oder Telefonkontakte.

Funktionen

Kontakt anrufen

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie N zum Anrufen.

Hinweis: Wenn ein Kontakt mehrere Rufnummern 
oder E-Mail-Adressen enthält, drücken Sie S 
links/rechts, um die gewünschte Nummer oder 
E-Mail-Adresse auszuwählen.

Nachricht an Kontakt senden

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Nachricht senden.

Funktionen
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Zusätzliche Rufnummer oder E-Mail-Adresse zu 
einem Kontakt hinzufügen

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Kontakt bearbeiten und S links/rechts, 
um die Registerkarte Details n auszuwählen.

Drücken Sie S oben/unten, um zu einem leeren 
Feld Nummer oder E-Mail zu blättern. Drücken Sie 
anschließend die mittlere Taste s, um es 
auszuwählen.

Hinweis: Diese Option ist für auf der SIM-Karte 
gespeicherte Kontakte nicht verfügbar.

Funktionen

Bild-ID für einen Kontakt festlegen

Ein Foto oder Bild zuweisen, das angezeigt wird, 
wenn der betreffende Kontakt anruft:

s > L Kontakte > Eintrag, drücken Sie Optionen 
> Kontakt bearbeiten und S links/rechts, um die 
Registerkarte Bild-ID q, > Bild auszuwählen.

Hinweis: Diese Option ist für auf der SIM-Karte 
gespeicherte Kontakte nicht verfügbar.

Signaltöne für Kontakt festlegen

Erkennbares Anrufsignal (Klingelton-ID) oder 
Nachrichtensignal für einen Kontakt festlegen:

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Kontakt bearbeiten und S links/rechts, 
um die Registerkarte Signale m, > Anrufsignaloder 
Nachrichtensignal auszuwählen.

Hinweis: Diese Option ist für auf der SIM-Karte 
gespeicherte Kontakte nicht verfügbar.

Funktionen
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Kontakt zu Kategorie zuweisen

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Kontakt bearbeiten und S links/rechts, 
um die Registerkarte Details n, > Kategorie 
auszuwählen.

Hinweis: Diese Option ist für auf der SIM-Karte 
gespeicherte Kontakte nicht verfügbar.

Kategorieansicht anzeigen

s > L Kontakte, drücken Sie Optionen > Filtern nach.

Sie können Kontakte in einer vordefinierten 
Kategorie (Familie, Freunde, Büro) oder die Kontakte 
in einer von Ihnen erstellten Kategorie anzeigen 
(wählen Sie Neue Kategorie erstellen).

Funktionen

Klingeltöne oder Bild-ID für Kategorie festlegen

Erkennbares Anrufsignal (Klingelton-ID), 
Nachrichtensignal oder eine Bild-ID für Kontakte in 
einer bestimmten Kategorie festlegen:

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > Kategorien bearbeiten > Kategorie.

Verteilerliste erstellen

Kontakte zu einer Gruppennachrichtenliste oder 
E-Mail-Liste zuweisen:

s > L Kontakte, drücken Sie Optionen > Neu erstellen 
> Nachrichtenliste oder E-Mail-Liste.

Hinweis: Diese Option ist für auf der SIM-Karte 
gespeicherte Kontakte nicht verfügbar.

Funktionen
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Kontaktfotos anzeigen

Kontakte mit Bild-ID-Fotos oder als Textliste 
anzeigen:

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > Kontakteinstellungen > Standardansicht 
> Thumbnail oder Liste.

Sortierreihenfolge der Kontaktliste festlegen

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > Kontakteinstellungen > Std.-Sortierreihenf. 
> Vorname oder Nachname.

Alle Kontakte auf SIM-Karte kopieren

Alle Kontakte aus dem Telefonspeicher auf die 
SIM-Karte kopieren:

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > Alle auf SIM kopieren.

Funktionen

Kontakte synchronisieren

Kontaktliste per FOTA (Firmware Over 
the air) mit dem Microsoft® Exchange 
2003-Server mithilfe von MOTOSYNC 
synchronisieren:

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > Synchronisieren.

Weitere Informationen finden Sie auf Seite 56.

Kontakt an ein anderes Gerät senden

Kontakt an ein anderes Telefon, einen Computer oder 
ein anderes Gerät senden:

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Kontakt senden via > Bluetooth oder Nachricht.

Kontakt löschen

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Kontakt löschen.

Funktionen



84 Sonstige Funktionen—Erweitertes Personalisieren

Erweitertes 
PersonalisierenMehrere Kontakte löschen

s > L Kontakte, drücken Sie Optionen 
> Mehrere markieren, wählen Sie die zu löschenden 
Kontakte, drücken Sie Optionen > Löschen.

Alle Kontakte löschen

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > Alle Kontakte löschen.

vCard importieren

Importieren Sie Kontaktinformationen von einer 
vCard-Datei, die im Telefon gespeichert ist.

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > vCard importieren.

Besitzerinformationen speichern

Speichern Sie Informationen über sich selbst auf 
dem Telefon.

s > L Kontakte, drücken Sie Optionen 
> Kontakte verwalten > Besitzerinformationen.

Funktionen

Funktionen

Sprache

Menüsprache festlegen:

s > u Setup > Telefon > Sprache

Erinnerungen

Erinnerungssignal für Terminbenachrichtigungen 
festlegen:

s > u Setup > Profile, wählen Sie ein Profil zum 
Bearbeiten aus und drücken Sie S links/rechts, um 
die Registerkarte Einstellungen #, > Erinnerungssignal 
auszuwählen.
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Uhrzeit-Anzeige

Analog- oder Digitaluhr im Standby-Display anzeigen 
oder Uhr deaktivieren:

Drücken Sie Optionen > Standby-Display anpassen > Uhr im 
Standby-Display.

Datumsanzeige

Datum im Standby-Display anzeigen oder 
deaktivieren:

Drücken Sie Optionen > Standby-Display anpassen > Datum im 
Standby-Display.

Einstellungen zurücksetzen

Zurücksetzen aller Optionen auf ihre werkseitigen 
Einstellungen, mit Ausnahme von Entsperrcode, 
Sicherheitscode und Lebenszeit-Timer:

s > u Setup > Telefon > Zurücksetzen 
> Alle Einst. zurückset.

Funktionen

Daten löschen

Vorsicht: Diese Option löscht alle von Ihnen 
eingegebenen Daten (einschließlich Kontakte und 
Kalendereinträge) sowie alle heruntergeladenen 
Inhalte im Speicher des Mobiltelefons (einschließlich 
Fotos und Sounddateien). Diese Daten können nach 
dem Löschen nicht wiederhergestellt werden.

Mit dieser Option werden die Daten auf der 
SIM-Karte nicht gelöscht:

s > u  Setup > Telefon > Zurücksetzen > Alle Daten löschen

Daten auf Speicherkarte bzw. SIM-Karte löschen

Vorsicht: Diese Option löscht alle Daten 
(einschließlich Kontakte) auf der SIM-Karte. Die 
Daten können nach dem Löschen nicht 
wiederhergestellt werden.

s > u  Setup > Telefon > Zurücksetzen 
> Speicherkarte löschen > SIM-Karte

Funktionen
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Gesprächsdauer und 
-gebühren
Die Netzverbindungszeit ist die Zeit, die zwischen 
Verbindung zum Netz und Beenden der Verbindung 
durch Drücken von O liegt. Dies umfasst auch 
Besetztzeichen und Klingeltöne.

Eventuell stimmt die Zeit, die Sie mit Ihren Ruf-Timern 
erfassen, nicht mit der Verbindungsdauer überein, die 
Ihnen von dem Diensteanbieter berechnet wird. Wenn 
Sie Informationen zu Ihrer Abrechnung benötigen, 
wenden Sie sich an Ihren Diensteanbieter.

Funktionen

Gesprächszeit

Gesprächstimer anzeigen:

s > q Anrufliste, drücken Sie Optionen > Gesprächszeit.

Gesprächs-Timer

Anrufzeit während eines Anrufs anzeigen:

s > u Setup > Anrufe > Gesprächsoptionen 
> Gesprächstimer

Gesprächsgebühren

Gebührenzähler und Guthabeninformationen 
anzeigen:

s > q Anrufliste, drücken Sie Optionen > Anrufkosten.

Gesprächsgebühreneinrichtung

Guthaben einstellen:

s > q Anrufliste, drücken Sie Optionen > Anrufkosten 
> Anrufkosten-Setup.

Datenzeiten

Datenruf-Timer anzeigen:

s > q Anrufliste, drücken Sie Optionen > Datenzeiten.

Funktionen



87Sonstige Funktionen—Freisprecheinrichtungen

Freisprecheinrichtungen
Hinweis: Die Benutzung von Mobiltelefonen kann beim 
Führen eines Kfz Ablenkungen verursachen. Wenn Sie 
sich nicht auf das Fahren konzentrieren können, 
beenden Sie das Gespräch. Außerdem ist die 
Verwendung von drahtlosen Geräten und deren 
Zubehör in bestimmten Umgebungen verboten. 

Befolgen Sie überall die entsprechenden Gesetze und 
Bestimmungen.

Datenmengen

Datenmengenzähler anzeigen:

s > q Anrufliste, drücken Sie Optionen > Datenmengen.

Funktionen

Funktionen

Lautsprecher

Lautsprecher während eines Anrufs 
aktivieren:

Drücken Sie Lautspr..

Automatische Rufannahme (Headset)

Automatische Rufannahme, wenn ein 
Autoeinbausatz oder Headset angeschlossen ist:

s > u Setup > Telefon > Headset-Einstell. > Auto-Antwort

Sprachwahl (Headset)

Sprachwahl mit der Sende-/Endetaste des 
Headsets aktivieren:

s > u Setup > Telefon > Headset-Einstell. > Sprachwahl
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Netz Tools
Funktionen

Netzeinstellungen

Netzinformationen anzeigen und 
Netzeinstellungen anpassen:

s > u Setup > Netz

Software-Update

Ihr Diensteanbieter kann Software-Updates 
über das Mobilfunknetz an Ihr Telefon senden. Wenn 
Sie ein Update mit dem Telefon empfangen, können 
Sie es sofort installieren oder die Installation auf 
einen späteren Zeitpunkt verschieben. So installieren 
Sie ein verschobenes Software-Update:

s > u Setup > Telefon > Software-Update > Installieren

Funktionen

Weckfunktion einstellen

s > m Tools > Wecker

Schnellzugriff: Drücken Sie Optionen > Alarm einstellen 
im Standby-Display.

Alarm ausschalten

Auf dem Display wird ein Alarm angezeigt: 

Drücken Sie zum Abschalten des Alarmtons Ablehnen 
oder O.

Um den Alarmton für acht Minuten 
stummzuschalten, drücken Sie Erneut erinnern.

Standardansicht des Kalenders einstellen

s > m Tools > Kalender, drücken Sie Optionen 
> Kalender-Setup > Standardansicht.
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Neuen Kalendertermin hinzufügen

s > m Tools > Kalender, wählen Sie den Tag und die 
Startzeit aus, drücken Sie s, geben Sie die 
Termindetails ein.

Als Terminerinnerung können Sie eine Musikdatei, 
eine Sprachaufnahme oder ein Video festlegen. 
Wenn Sie einen Kalendertermin erstellen, wählen Sie 
Alarmstil > Signaltyp, blättern Sie zu der Datei (oder 
erstellen Sie eine neue Datei), drücken Sie Einfügen.

Kalendertermin anzeigen

s > m Tools > Kalender > Termin

Um die Termindetails zu bearbeiten, drücken Sie 
Optionen > Bearbeiten.

Funktionen

Terminerinnerung

Auf dem Display wird eine Terminerinnerung 
angezeigt und ein Signal dafür ausgegeben:

Wählen Sie Termin öffnen, um die Details der Erinnerung 
anzuzeigen.

Drücken Sie Ablehnen, um die Erinnerung zu schließen.

Kalendereintrag an ein anderes Gerät senden

Kalendertermin an ein anderes Mobiltelefon, einen 
Computer oder ein anderes Gerät senden:

s > m Tools > Kalender > Termin, drücken Sie 
Optionen > Termin mitteilen via > Bluetooth oder Nachricht.

Heruntergeladene Dateien verwalten

Dateien und Anwendungen verwalten, die Sie vom 
Browser über eine Bluetooth®-Verbindung auf das 
Telefon heruntergeladen haben:

s > m Tools > Download-Manager

Funktionen
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Dateien verwalten

So greifen Sie auf Multimedia-Dateien zu, die im 
Telefon gespeichert sind, und verwalten diese:

s > m Tools > Datei-Manager

Weltuhr

Uhrzeit und Datum für mehrere Städte in der ganzen 
Welt anzeigen:

s > m Tools > Weltuhr

Aufgabenliste

Checkliste für anstehende Aufgaben erstellen und 
das Telefon für die Benachrichtigung von fälligen 
Aufgaben einrichten:

s > m Tools > Aufgabenliste

Notizen:

Notizen auf dem Telefon schreiben und speichern:

s > m Tools > Notizen

Funktionen

Sprachaufzeichnung

s > j Multimedia > Voice Recorder, drücken Sie die 
mittlere Taste s, um die Aufzeichnung zu starten, 
drücken Sie Stopp, um die Aufzeichnung zu beenden.

Um die Sprachaufzeichnung zu speichern, drücken 
Sie Speichern.

Drücken Sie Optionen, um weitere Funktionen für 
die Sprachaufzeichnung auszuführen.

Hinweis: Die Aufnahme von Anrufen unterliegt 
den jeweils gültigen Gesetzen zu Datenschutz 
und Gesprächsaufzeichnung. Die Gesetze und 
Vorschriften zur Nutzung dieser Funktion müssen 
stets eingehalten werden.

Funktionen
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Sicherheit
Sprachaufzeichnung abspielen

So starten Sie die Wiedergabe einer 
Sprachaufzeichnung:

s > m Tools > Datei-Manager > Sprachmemos 
> Sprachaufzeichnung

Rechner

s > m Tools > Rechner

Währungsrechner

s > m Tools > Rechner, drücken Sie Optionen 
> Wechselkurs einstellen, geben Sie den Wechselkurs ein, 
drücken Sie Einstellen, geben Sie den Betrag ein, 
drücken Sie Optionen > Währung umwandeln.

Funktionen

Funktionen

SIM-PIN

Vorsicht: Wenn Sie drei Mal hintereinander einen 
falschen PIN-Code eingeben, wird Ihre SIM-Karte 
deaktiviert und im Display erscheint SIM gesperrt.

SIM-Karte sperren oder entsperren:

s > u Setup > Sicherheit > SIM-PIN

Sperren von Anwendungen

s > u Setup > Sicherheit > Anwendungssperre
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Spaß und Spiel
Zertifikatverwaltung

Im Telefon gespeicherte Zertifikate für den 
Internet-Zugriff aktivieren oder deaktivieren:

s > u Setup > Sicherheit > Zertifikate

Zertifikate ermöglichen es Ihnen, beim 
Herunterladen von Dateien oder bei der Freigabe 
von Informationen die Identität und Sicherheit 
von Websites zu prüfen.

Funktionen

Funktionen

Musik und Sounds verwalten

Heruntergeladene Musik und Signaltöne 
verwalten:

Drücken Sie [.

Blättern Sie zu einer Sounddatei, und drücken Sie 
dann Optionen, um die Datei zu löschen, 
umzubenennen, zu kopieren, zu verschieben, 
zu senden oder anzuwenden. Einige Operationen 
können nicht für bestimmte urheberrechtlich 
geschützte oder vorinstallierte Dateien ausgeführt 
werden.

Musik- oder Sounddatei wiedergeben

Drücken Sie [ > Sounddatei.
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Bilder verwalten

s > j Multimedia > Bilder

Blättern Sie zu einer Bilddatei, und drücken Sie dann 
Optionen, um die Datei zu löschen, umzubenennen, 
zu kopieren, zu verschieben, zu senden oder 
anzuwenden. Einige Operationen können nicht für 
bestimmte urheberrechtlich geschützte oder 
vorinstallierte Dateien ausgeführt werden.

Bild bearbeiten

s > j Multimedia > Bilder > Bild, drücken Sie Optionen 
> Bearbeiten.

Urheberrechtlich geschützte oder vorinstallierte 
Dateien können nicht bearbeitet werden.

Funktionen

Videos verwalten

s > j Multimedia > Videos

Blättern Sie zu einer Bilddatei, und drücken Sie dann 
Optionen, um das Video zu löschen, umzubenennen, 
zu kopieren, zu verschieben oder zu senden. 
Einige Operationen können nicht für bestimmte 
urheberrechtlich geschützte oder vorinstallierte 
Dateien ausgeführt werden.

Spiel oder Anwendung starten

Java™-Spiel oder -Applikation starten:

s > T Spiele > Spiel oder Anwendung

SIM-Anwendungen verwenden

Die SIM-Karte enthält eventuell weitere 
Anwendungen, mit denen die Funktionalität des 
Telefons erweitert wird. Weitere Informationen 
erhalten Sie von Ihrem Diensteanbieter.

s > m Tools > SIM-Anwendungen

Funktionen
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Flugzeugmodus

Schalten Sie die Anruffunktionen des Telefons an 
Orten aus, wo Mobiltelefone verboten sind. Mit 
dieser Option können Sie den Musik-Player und 
andere Funktionen, die nicht vom Netz abhängig 
sind, verwenden, wenn Sie sich in einem Flugzeug 
befinden, ohne die Kommunikationsfunktionen des 
Flugzeugs zu stören.

Drücken Sie Optionen > Flugzeugmodus aktiv. > Ja im 
Standby-Display.

So deaktivieren Sie den Flugzeugmodus und 
aktivieren die Anruffunktionen des Telefons erneut:

Drücken Sie Optionen > Flugzeugmodus deaktiv. > Ja im 
Standby-Display.

Funktionen



95SAR-Daten

0,340,34
SAR-DatenDaten zur spezifischen Absorptionsrate

DIESES TELEFONMODELL ENTSPRICHT DEN 
INTERNATIONALEN RICHTLINIEN FÜR DIE BEGRENZUNG 
DER EXPOSITION DURCH ELEKTROMAGNETISCHE 
FELDER

Ihr Mobiltelefon ist ein Radiosender und -empfänger. Es ist 
so konzipiert, dass die international empfohlenen 
Höchstwerte für die Belastung durch elektromagnetische 
Felder nicht überschritten werden. Diese Richtlinien wurden 
von einer unabhängigen wissenschaftlichen Organisation, 
der ICNIRP, erarbeitet und beinhalten Sicherheitsfaktoren, 
die den Schutz aller Personen unabhängig von Alter und 
Gesundheitszustand sicherstellen.

Die Richtlinien verwenden eine Maßeinheit, die als SAR 
(Specific Absorption Rate) oder spezifische Absorptionsrate 
bezeichnet wird. Die von der ICNIRP festgelegte SAR-
Höchstgrenze (ICNIRP SAR) für Mobilfunkgeräte beträgt für 
die allgemeine Bevölkerung 2 W/kg. Der höchste SAR-Wert, 
der bei Prüfungen mit diesem Gerät am Ohr gemessen 
wurde, betrug 0,34 W/kg1. Da Mobilfunkgeräte die 

verschiedensten Funktionen bereitstellen, können sie auch 
an anderen Betriebspositionen verwendet werden, 
beispielsweise am Körper2 (siehe Bedienungsanleitung). In 
diesem Fall betrug der höchste gemessene SAR-Wert 
0,63 W/kg1.

Da der SAR-Wert bei der maximalen Sendeleistung des 
Mobilfunkgeräts gemessen wird, liegt der tatsächliche SAR-
Wert für dieses Gerät während des Betriebs typischerweise 
unter dem genannten Wert. Das ist darauf zurückzuführen, 
dass die Sendeleistung des Geräts automatisch auf den 
geringst möglichen Wert eingestellt wird, der erforderlich 
ist, um das Netzwerk zu erreichen. 
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SAR-Werte für verschiedene Telefone und Bedienpositionen 
können voneinander abweichen. Sie entsprechen jedoch 
alle den behördlichen Anforderungen für einen sicheren 
Betrieb. Bitte beachten Sie, dass technische 
Weiterentwicklungen an diesem Modell zu veränderten 
SAR-Werten für neuere Produkte führen können. In allen 
Fällen genügen die SAR-Werte aber den Anforderungen der 
Richtlinien.

Nach Einschätzung der Weltgesundheitsorganisation 
(WHO) sind nach dem gegenwärtigen Stand der 
Wissenschaft keine besonderen Vorsichtsmaßnahmen für 
den Betrieb von Mobilfunkgeräten erforderlich. Um die 
Belastung zu verringern, empfiehlt sie, die Dauer von 
Gesprächen zu begrenzen und/oder 
Freisprecheinrichtungen einzusetzen, um einen möglichst 
großen Abstand zwischen Mobilfunkgerät und Kopf bzw. 
Körper einzuhalten. 

Weitere Informationen hierzu finden Sie auf den Websites 
der Weltgesundheitsorganisation (http://
www.who.int/emf) und von Motorola, Inc. 
(http://www.motorola.com/rfhealth).

1. Die Tests wurden in Übereinstimmung mit 
internationalen Prüfrichtlinien durchgeführt. Der 
Höchstwert enthält einen erheblichen 
Sicherheitsfaktor als zusätzlichen Schutz für die 
Bevölkerung und zur Berücksichtigung von 
möglichen Messabweichungen. Weitere 
Informationen hierzu finden Sie im Motorola 
Testprotokoll sowie den Unterlagen zum 
Beurteilungsverfahren und zur 
Messfehlergenauigkeit für dieses Produkt.

2. Bitte beachten Sie für den körpernahen Betrieb den 
Abschnitt Sicherheitsrelevante und allgemeine 
Informationen.
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WHO-Informationen
WHO-InformationenInformationen der WHO 
(Weltgesundheitsorganisation)

Derzeitige wissenschaftliche Studien lassen keinerlei 
Notwendigkeit für spezielle Vorsichtsmaßnahmen bei der 
Verwendung von Mobiltelefonen erkennen. Wenn Sie 
sich und Ihre Kinder vor Funkfrequenzemissionen 
schützen wollen, können Sie die Anrufdauer beschränken 
oder Freisprecheinrichtungen verwenden, um den 
Abstand zwischen Kopf bzw. Körper und Telefon zu 
vergrößern.

Quelle: WHO Fact Sheet 193

Weitere Informationen: 
http://www.who.int./peh-emf
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Informationen zu OSSINFORMATIONEN ZU OPEN SOURCE 
SOFTWARE

Senden Sie eine E-Mail an 
ossmanagement@motorola.com, um Informationen zu 
erhalten, wie Sie eine Kopie der von Motorola öffentlich 
zur Verfügung gestellten Quellcodes erhalten können, die 
in der Software dieses Mobiltelefons von Motorola 
verwendet werden.
Sie können auch eine schriftliche Anfrage an folgende 
Adresse senden:

Die Website opensource.motorola.com von Motorola 
enthält ebenfalls Informationen über die Verwendung von 
Open Source durch Motorola.
Die von Motorola erstellte Website 
opensource.motorola.com soll als Portal zur Interaktion mit 
der Software-Community dienen.

Um weitere Informationen zu Lizenzen, Bestätigungen 
und erforderlichen Urheberrechtshinweisen für Open 
Source-Pakete zu erhalten, die in diesem Mobiltelefon 
von Motorola enthalten sind, führen Sie 
die nachstehenden Schritte aus:
1 Wählen Sie im Hauptmenü die Option Tools.
2 Wählen Sie im Menü Tools die Option Datei-Manager.
3 Wählen Sie im Menü Datei-Manager den Ordner 

OpenSource.
4 Markieren Sie OpenSourceNotices.html, und drücken Sie 

Auswählen. Dadurch wird der Browser gestartet, und 
das Dokument mit den Hinweisen wird geöffnet.

MOTOROLA, INC.
OSS Management
600 North US Hwy 45
Libertyville, IL 60048
USA
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Entsperrcode eingeben (Meldung)  

37
Entsperren

Anwendung  91
Externe Tasten  37
Mobiltelefon  37
SIM-Karte  91
Telefon  38
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I
IM  65
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K
Kabel verwenden  69
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Senden, Termin  89
Synchronisieren  67, 68
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Kamera  3, 55, 58
Kein Signal, Profil  39
Klappe  32, 45
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40
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Kontakte filtern  82
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Ansicht  82
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Koppeln. Siehe Bluetooth Wireless
Kurzwahl  76

L
Lautsprecher  87
Lautstärke  31, 39, 40
Lautstärketasten  3, 31
Lichtsignal  81
Löschen-/Rücktaste  29

M
Mailing-Liste  82
Medienlautstärke einstellen  39, 40
Medienwiedergabe  39, 40
Menü  4, 25
Menüsymbole  26
Menütaste  21
MFV-Töne  79
Micro-USB-Anschluss  3, 22, 69
Mittlere Taste  21, 32
MMS herunterladen  64
MMS-Nachricht  61, 63

MOTOSYNC  67, 68
MP3-Sounddateien  50
Musik  92
Musik-Player  50

N
Nachricht  61

Gelesen  62, 63
Sende-  61

Nachrichten  61
Nachrichten. Siehe IM
Nachrichtenerinnerungen  84
Nachrichtensignal  81
Nachrichtensymbol  27, 62
Navigationstaste  21, 32
Netzeinstellungen  88
Niedriger Akkustand (Meldung)  27
Notizen:  90
Notrufnummer  48
Numerischer Modus  31

O
Öffnen zum Annehmen eines 

Anrufs  45
Optionale Funktion  22
Optionale Funktionen  22
Optionales Zubehör  22

P
Passwörter Siehe Codes
Personalisieren  84
PIN2-Code  37, 78
PIN-Code  37, 91
Positionsanzeige  27
Profilanzeige  27
Profile  27, 39

R
Rechner  91
Rufnummer

Eigene Nummer  78
Speichern  80

Rufnummern speichern  80
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Rufumleitung  77
Rufumleitungsanzeige  27

S
Screensaver  42, 44
Seitliche Auswahltaste  3, 32, 33
Service-Rufnummer  79
Sicherheitscode  36
Signal

Ausschalten  31, 46
Einstellen  33, 39, 42

Signalprofil  39
Signalstärkeanzeige  26
Signalton  39, 42, 53, 92
Signaltyp  33
Signaltyp-Profile  27
SIM gesperrt (Meldung)  91
SIM-Anwendungen  93
SIM-Karte  37, 78, 79, 91
Skin  42
Smart-Taste  33
Softkeys  25
Software-Update  75, 88

Sperren
Anwendung  91
Externe Tasten  37
SIM-Karte  91
Telefon  38

Sprachaufzeichnung  90, 91
Sprachbefehle  33
Sprachbefehltaste  3, 34
Sprache  84
Sprachnachrichten  49
Sprachnachricht-Symbol  49
Sprachwahl  33, 87
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Stummschaltung  33
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Synchronisieren  67, 68

T
Tastatur  45
Tastaturlautstärke einstellen  39, 40
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Texteingabe  28
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Textvorlage  63
Textvorlagen  63
Theme  42
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TTY-Gerät  78

U
Uhrzeit  41, 85
Umleiten von Anrufen  77
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V
Verbinden. Siehe Bluetooth 
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Vibrationsmodus  33
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Videoblog  54
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Wallpaper  42
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Wecker  88
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Z
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Zurückrufen  33, 47

U.S. patent Re. 34,976



104 Index

6803570F13



105Index





www.motorola.com


	HELLOMOTO
	Inhalt
	Sicherheitsinformationen
	Hinweise betreffend FCC (Federal Communications Commission)
	Benutzung und Pflege
	EU-Richtlinien Konformitätserklärung
	Informationen zum Recycling
	Grundlagen
	Informationen zu diesem Handbuch
	Akku

	Grundlagen
	Display
	Texteingabe
	Lautstärke
	Navigationstaste
	Seitliche Auswahltaste
	Externes Display
	Sprachbefehle
	Sprachmodus
	Freisprechfunktion
	Codes und Passwörter
	Seitentasten sperren und freigeben
	Mobiltelefon sperren/entsperren

	Personalisieren
	Profile
	Zeit und Datum
	Themes
	Displayeinstellungen
	Rufannahme

	Anrufe
	Abschalten des Anrufsignals
	Anrufliste
	Wahlwiederholung
	Zurückrufen
	Anrufer-Display
	Notrufe
	Sprachnachrichten

	Unterhaltung
	Musik-Player
	Browser
	Kamera
	Video

	Nachrichten
	Instant Messaging

	Verbindungen
	MOTOSYNC
	Datei-Manager
	Kabelverbindungen
	Bluetooth®- Verbindungen
	Mobiltelefon-Updates

	Sonstige Funktionen
	Erweiterte Anruffunktionen
	Kontakte
	Erweitertes Personalisieren
	Gesprächsdauer und -gebühren
	Freisprecheinrichtungen
	Netz
	Tools
	Sicherheit
	Spaß und Spiel

	SAR-Daten
	WHO-Informationen
	Informationen zu OSS
	Index

